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Step Into The Music Studio 

With The Music Studio you now have, at your fingertips, a 
complete set of music composing tools. You can write, edit, 
and store both music and lyrics. You can play back any song 
using a variety of instruments selected from The Music 

Studio sound libraries. And if you have the urge to 
improvise, you can use the special Music Paintbox to create 
music by "painting" colored notes on the staff. 

The Music Studio gives you a full set of composing features 
to work with. You can use a wide variety of musical 
notation- sharps, flats, rests, ties, dotted notes, triplets, 
accents, and more. You can change a song to a new key 
instantly. You can copy or move sections of music, transpose 
passages up or down, insert new passages, and experiment 
with different tempos. And you can do it all with no more 
than a click of your mouse. 

How to Use This Guide 

This guide has five sections. 

"Getting Started" is a brief section to help you get The Music 

Studio running and introduce you to some terms used in this 
guide. 

"Using the Main Composing Screen" takes you through the 
basic features of The Music Studio, from playing one of the 
pre-programmed songs on the Music Studio disk to creating 
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a song of your own. The Main Composing Screen is the real 
heart of The Music Studio, the place where you make music. 

"Exploring Sound" shows you how to customize your sound 
palette to suit your own taste. You can control any sound­
molding its dynamics as you would with a synthesizer. And if 
you have the optional MIDI interface for your computer, 
you'll be able to connect many synthesizers and make them 
play the tunes you write with The Music Studio. 

"Using the Music Paintbox" introduces you to one of The 
Music Studio's special features. With the Paintbox, you can 
create real free-form music, painting colored rectangles onto 
the screen as notes instead of using formal musical notation. 

The "Reference Guide" is your complete guide to The Music 
Studio. In this section, you'll find explanations of every 
menu, every symbol, and every feature in The Music Studio. 
All references are organized according to the way they 
appear on the screen, with functions from the same menu 
grouped together. At the end of the section, you'll also find a 

short glossary of musical terms. 

A Note to the Adventurous 

If you'd rather explore The Music Studio on your own 
instead of working through this guided tour, go right ahead. 
The Music Studio is a very straightforward program, and all 
the options work just as you'd expect them to. 
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If you want information on loading The Music Studio, check 
the "Getting Started" section (page 5). Once you've got The 
Music Studio running, just use your mouse to make 
selections from the pull-down and pop-up menus. After 
you've got the feel of The Music Studio, you can use the 
"Reference Guide" (pages 77- 121) to get complete 
information on all The Music Studio's functions. 
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Getting Started 

You can start work in The Music Studio almost as soon as 
you get the Music Studio program disk out of its box. Here's 
what you need to know: 

• The Music Studio program disk. 

• A blank, formatted disk, to save the songs you create. 

• A printer, if you want to print out the songs you've 
written. 

Starting The Music Studio 

There are two ways to start The Music Studio depending on 
whether your computer is off or on. 

Warning: The Music Studio program disk is copy­
protected, so you can't make copies of the disk. To replace a 
defective disk, see the warranty information at the back of 
this guide. 

Jf the computer is off: 

1. Turn on the monitor- but not the computer. 

2. Put the Music Studio program disk in the internal disk 
drive, with the label side up. 
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3. Turn on the computer. The computer will automatically 
start loading The Music Studio from the disk In a few 
moments, the screen will brighten, the Music Studio title 
screen will appear, and the theme music will start. 

4. If you click the mouse button, the theme music will stop, 
and the Main Composing Screen will appear. If you don't 
click the mouse button, the theme music will play to its 
end, and the Main Composing Screen will appear. 

q the computer is on: 

1. Put the Music Studio program disk in the internal disk 
drive, with the label side up. 

2. Reset the computer by pressing the reset key, the 
control key, and the command key all at the same 
time. The command key is located near the lower left 
corner of the keyboard and looks like this: 
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When you press these three keys, the computer will reset 
itself and automatically load The Music Studio from the 
disk In a few moments, the screen will brighten, the 
Music Studio title screen will appear, and the theme 
music will start. 



3. If you click the mouse button, the theme music will stop, 
and the Main Composing Screen will appear. If you don't 
click the mouse button, the theme music will play to its 
end, and the Main Composing Screen will appear. 

Using the Mouse 

Almost everything you do in The Music Studio, you do with 
the mouse. This guide uses four terms to designate the 
different ways you can use the mouse: 

Click means position the pointer (usually on a box or 
symbol) and then press and quickly release the button on 
the mouse. 

Double-click means position the pointer and then press 
and quickly release the mouse button twice. 

Drag means position the pointer and then hold down the 
mouse button while you move the mouse. You release the 
mouse button when the item you want is highlighted. 

Press means position the pointer and then hold down the 
mouse button without moving the mouse. 
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A Note on Type Styles 

In this guide, boldface type is used for words and messages 
that appear on the screen. For example, 

Move the pointer to Options 

means that you're to move the mouse pointer to where the 
word Options is printed on the screen. 
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Using the Main Composing 
Screen 

After the Music Studio title screen, the first screen you'll see 
is the Main Composing Screen. This screen contains all the 
tools you need to create your own music, and it's here that 
you'll probably spend most of your time. 

Pull-Down and Pop-Up Menus 

Most of the features on the Main Composing Screen are kept 
out of sight (and out of your way) on pull-down or pop-up 
menus. You can think of these menus as rolled up window 
shades with the menu choices written on them. To see the 
choices on a particular menu, you must "pop it up" or "pull 
it down," like a window shade. 
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For example, here's how to select the key signature to place 
on the musical staff: 

1. Move the pointer to the key signature symbol at the 
bottom left of the Main Composing Screen. 

2. Press and hold the mouse button. The white background 
behind the key signature symbol will turn magenta, and 
the stack of key signature choices will pop up on the 
screen. 

3. Still holding down the mouse button, drag the pointer up 
and down the menu stack, until the key signature you 
want is highlighted with the magenta background. Then 
release the mouse button-the menu will disappear, the 
key signature symbol you selected will show at the 
bottom of the screen, and the grand staff will now be set 
to the proper key. 

Experiment with the other pull-down and pop-up menus to 
see what's on them. As you do, keep your eye on the 
message box at the top of the screen- it gives you a 
running status report, telling you what each symbol means 
when you highlight it and which feature is currently active. 

Playing Music 

Before beginning to write music of your own, take a few 
minutes to preview what music looks and sounds like in The 

Music Studio. You can start by loading and playing any of 
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the pre-programmed songs that are stored on the Music 
Studio program disk. To load any of these songs, you must 
go to the Song Files Screen: 

Loading a Song 

The procedure for loading and playing the pre-programmed 
songs is the same one you'll later use for loading and playing 
your own music. 

To load a song from the program disk: 

1. Move the pointer to the word File in the upper left 
corner of the screen, and press the mouse button to pull 
down the menu. Still holding down the mouse button, 
drag the pointer down to highlight SONG Files. Release 
the mouse button, and the Song Files Screen will appear, 
along with a list of songs on the Music Studio program 
disk. 
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2. Move the pointer to the word Load, and click the mouse 
button. Load will be highlighted. 

3. Scroll through the list of songs, using the mouse to drag 
the slider bar at the right side of the file list up or down. 
When you see a song you want to load, move the pointer 
to the song name so that the name is highlighted, and 
then click the mouse button. After a few seconds, the 
words File Loaded along with the song name will 
appear in the bottom left corner of the Song Files Screen. 

4. Move the pointer to the word Done, and click the 
mouse button. The program will return to the Main 
Composing Screen. The music for the song you selected 
will be written on the grand staff, and the song title will 
appear at the top of the screen. 

Playing a Song 

The Ear and the Running Note. Move 
the pointer to the ear symbol, at the bottom 
left part of the screen, or to the running note 
symbol just below it, and click the mouse 
button to play any song that you have loaded, 
either a pre-programmed song or your own 
composition. When you play a song by 
selecting the running note, the music scrolls 

across the screen as it's played. 
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To play a song: 

1. Once you have some music loaded, move the pointer to 
the ear symbol or the running note symbol in the lower 
left corner of the Main Composing Screen. Click the 
mouse button, and the music will start to play. 

2. To stop the music before it reaches the end of the song, 
just click the mouse button again. 

If you started the song by selecting the ear symbol, then 
the grand staff will display the beginning of the song again. 

If you started the song by selecting the running note 
symbol, then the grand staff will display the song starting 
at the point where you interrupted it. If you select the 
running note again, the music will play, starting with the 
note in the leftmost column on the screen. 

Advancing and Reversing the Music 

Take a look at the song slider- the long blue bar that 
stretches across the bottom of the Main Composing Screen 
below the grand staff. 

The number at the left end of the song slider shows the 
current column number (a column is a vertical space on the 
grand staff the width of one note or rest). If you move the 
pointer to the grand staff area, you will see that the current 
column number changes according to the position of the 
pointer. 

13 



The number at the right end of the song slider shows the 
total column number (the full length of the song in 
columns). 

You can move directly to the beginning of any song by 
clicking the mouse on the number at the left end of the 
slider. You can move directly to the end of the song by 
clicking the mouse on the total column number at the right 
end of the slider. 

To advance or reverse the music: 

1. Move the pointer to the black square inside the song 
slider. 

2. Press the mouse button and drag the black square left and 
right. Notice that the current column number on the left 
changes as you move the square back and forth in the 
song slider. 

3. If you hold the mouse still for more than one second, or 
if you release the mouse button, the screen will display 
the segment of the song represented by the black square's 
position in the song slider. 

To step through the music one column at a time: 

1. Move the pointer to the right edge of the grand staff until 
two blue arrows appear, pointing to the left. 
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2. Click the mouse button. The music will move one 
column to the left, and the current column number (to 
the left of the song slider) will increase by one. As you 
click the mouse button again and again, the music will 
move left column by column. 

3. Move the pointer to the left edge of the grand staff until 
two blue arrows appear, pointing to the right. Click the 
mouse button once- the music will move one column to 
the right, and the current column number will decrease 
by one. 

To scroll the music right or left continuously, just 
press and hold the mouse button. 

Erasing Music 

You can erase any song from the screen to make room for a 
new one. If the song on the screen is one of the pre­
programmed songs from the Music Studio program disk, you 
can safely erase it from the screen- the song will remain on 
the disk for you to reload at any time. If you erase music that 
you have created without first saving it, however, you'll 
permanently lose the song (see "Saving a Song," page 29). 

The Trash Can. Point to the trash can, in the 
lower right corner of the Main Composing 
Screen, and double-click the mouse button to 
erase the currently loaded song from the screen. 
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To throw away a song: 

1. Move the pointer to the trash can symbol, and click the 
mouse button once. The trash can symbol will be 
highlighted, and the message box at the top of the screen 
will say Erase Song. 

If you change your mind after clicking the mouse button 
once, just move the pointer away from the trash can. The 
symbol will no longer be highlighted and the Erase 
Song message will disappear. Your song will not be 
erased. 

2. Click the mouse button a second time to erase the 
song- the song will disappear from the screen. 

If you change your mind after the song disappears from 
the screen, move the pointer to the trash can and double­
click the mouse before you do anything else. Your song will 
reappear. 

Creating an Original Song 

You can do all of your music composing and editing on the 
Main Composing Screen by placing notes, rests, measure 
bars, and other musical symbols on the grand staff. You can 
adjust the volume and tempo, transpose automatically from 
one key to another, assign a time signature, and arrange a 
composition for several different instruments. 
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Choosing an Instrument 

The Instrument Palette. Point to the 
instrument palette symbol, at the top left side 
of the Main Composing Screen, and press the 
mouse button to pull down the instrument 

palette. From this palette, you can select an instrument to 
create music with. 

The Music Studio comes with a variety of instrument sounds, 
represented as colors and numbers in a palette that pulls 
down from the instrument palette symbol at the top of the 
screen. You'll find this symbol below the File menu and 
between the note symbol and the tie bar symbol. 

A song may use one instrument or several different 
instruments from the instrument palette. When you first 
enter The Music Studio, the instrument at the top of the 
palette ( # 1) is gray. Unless you change to another 
instrument, all the notes you place on the grand staff will be 
gray and will sound like the instrument assigned to that color. 

To select an instrument: 

1. Move the pointer to the instrument palette symbol, and 
press the mouse button to pull d~wn the full instrument 
palette. 

2. Drag the pointer down the palette. As you point to each 
instrument color, the message box will tell you which 
instrument is represented by that color and number. 
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3. When the pointer is on the instrument you want, release 
the mouse button. The instrument palette will disappear, 
and the instrument color and number you have chosen 
will appear in the instrument palette symbol box. 

Once you've chosen a new instrument, any notes you place 
on the grand staff will have the color of the new instrument 
so that you can keep track of what you're doing. 

You can use up to 15 instruments in a song or one 
instrument for the whole song. 

Placing and Erasing Notes 

The Note. Point to the note symbol, and 
press the mouse button to pull down the note 
menu. From this menu, you can select the 
duration of the notes you want to place on the 
grand staff. 

All notes you place on the staff will have the color of and be 
played by the currently selected instrument. You can, 
however, always reassign notes to different instruments (see 
"Replace Instrument" in the "Reference Guide," which starts 
on page 77). 

To place a note: 

1. Move the pointer to the note symbol at the top of the 
screen, and press and hold the mouse button to pull 
down a menu of different note durations. The note 
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Using the Main Composing Screen 
. ··~~·~···· ····~··~·· ····~········~ ... 

symbol will be highlighted, and the message box will say 
Select Note Duration. 

2. Drag the pointer down the menu. When the note 
duration you want is highlighted, release the mouse 
button. The menu will disappear, and the note you 
selected will appear as the note symbol. The new note 
symbol will be highlighted, and the message box will read 
Add Note with the note value you selected next to the 
message. 

3. Move the pointer to the grand staff. Notice that as soon as 
the pointer nears the staff, it turns into a note of the value 
you selected. As you move the note up and down the 
staff, the tones representing the pitch of every line and 
space touched by the note will sound, using the currently 
selected instrument. 

4. To place a note, position the pointer on a line or space of 
the staff, and click the mouse button. When you move the 
pointer aside, a note will remain in that position on the 
staff. 

5. You can continue placing notes on the staff in the same 
way. If you want a note to sound at the same time as your 
first note, place the new note above or below the first in 
the same column. If you want. the note to sound before or 
after your first note, place it to the left or right. Notice 
that as you move the pointer sideways, it "jumps" from 
column to column, making it easy for you to place your 
notes accurately. 
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You can place notes on the staff only where the pointer has 
the shape of a note. If you move the pointer too far above or 
below the staff or too far to the right or left, it will lose its 
note shape. 

Note: If you want to place notes without hearing the 
tones, select Tum Note Off from the Options menu (see 
"Turn Note Off" in the "Reference Guide," page 102). 

To erase a note: 

1. Use the pointer to position a note of any value on top of 
the note you want to erase. Make sure the pointer is 
directly over the note you want to erase, or you'll end up 
adding a new note instead of erasing one. 

2. Click the mouse button, and then move the pointer aside. 
The note you wanted to erase will be gone. 

Placing Rests, Sharps, Flats, Naturals, 
and Measure Bars 

To place or erase any of these musical notations, you use the 
same procedure that you use for notes. 

The Rest. Move the pointer to the rest 
symbol, and press and hold the mouse button 
to pull down the rest menu. From this menu, 
you can select the duration of the rests you 

want to place on the grand staff. 
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To place a rest: 

1. Move the pointer to the rest symbol at the top of the 
screen, and press and hold the mouse button to pull 
down a menu of rest durations. The rest symbol will be 
highlighted, and the message box will say Select Rest 
Duration. 

2. Drag the pointer down the menu until the rest duration 
you want is highlighted, and then release the mouse 
button. The menu will disappear, and the rest you 
selected will appear as the rest symbol. The new rest 
symbol will be highlighted, and the message box will read 
Add Rest with the rest value you selected next to the 
message. 

3. Move the pointer to the grand staff. The pointer will turn 
into the rest symbol you selected. To place a rest, 
position the pointer on the staff and click the mouse 
button, just as you did to place notes. 

To delete a rest: 

1. Select a rest of any duration, position the pointer directly 
on top of the rest you want to erase, and click the mouse 
button. When you move the pointer aside, the rest you 
wanted to erase will be gone. 

The Key Symbol. Move the pointer to the 
key symbol at the top of the screen and press 
the mouse button to pull down the key menu. 
From this menu, you can select accidentals-
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sharps, flats, and naturals- to add to the notes you place on 
the staff. 

To add sharps, flats, and naturals: 

1. Move the pointer to the key symbol, just to the right of 
the rest symbol, and press and hold the mouse button to 
pull down the key menu, containing a sharp, a flat, and a 
natural. The key symbol will be highlighted and the 
message box will say Stay in Current Key. 

2. Drag the pointer down the menu. As each accidental is 
highlighted, the message box will tell you what it is. 
When the accidental you want is highlighted, release the 
mouse button. The menu will disappear and the 
accidental you selected will take the place of the key 
symbol. 

3. Once you've selected an accidental, any note you place 
on the staff will have that accidental attached. 

To cancel a sharp, flat, or natural: 

1. Pull down the key menu again, and select the key symbol 
itself After you select the key symbol, the notes you 
place on the staff will not have an accidental attached. 
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The Tie Symbol. Move the pointer to the 
tie symbol at the top left corner of the screen, 
and press and hold the mouse button to pull 
down the tie menu. From this menu, you can 
select the tie to connect two notes. 



You can use the tie to link two adjacent notes that have 
identical pitches. Only notes on the same line or space of the 
grand staff that also have the same accidental have identical 
pitches. When two notes are tied, only the first note will 
sound, but the duration will be that of the two notes 
combined. 

To place a tie: 

1. Move the pointer to the tie symbol in the top left corner 
of the screen, and press and hold the mouse button to 
pull down the tie menu, revealing the measure bar 
symbol below. The tie symbol will be highlighted. Release 
the mouse button to select the tie. The message box will 
say Add Tie. 

2. Move the pointer (now a red tie) onto the staff, and place 
one end on the bottom of a note you want to tie. Click 
the mouse button. 

3. By moving the pointer, stretch the tie to the bottom of 
the second note, to the right or left of the first note, and 
click the mouse button again. The two notes will now be 
connected with a red tie. 

To delete a tie: 

1. Select the tie symbol again. 

2. Move the pointer (now a red tie) over the existing tie 
and click the mouse button, first at one end of the 

23 



existing tie, then at the other. The tie between the two 
notes will disappear. 

The Measure Bar. Below the tie symbol on 
the tie menu is the measure bar symbol. Select 
the measure bar symbol to place measure bars 
on the grand staff. 

To place a measure bar: 

1. Move the pointer to the tie symbol at the top left corner 
of the screen, and press and hold the mouse button to 
pull down the tie menu, revealing the measure bar 
symbol. 

2. Drag the pointer down to highlight the measure bar 
symbol, and release the mouse button. The measure bar 
symbol will replace the tie symbol at the top of the 
menu, and it will be highlighted. The message box will 
say Add Measure Bar. 

3. Move the pointer (now a measure bar) onto the grand 
staff, and position it where you want to place a measure 
bar. 

4. Click the mouse button. When you move the pointer 
aside, there will be a black measure bar on the staff. 

You can place measure bars wherever you want along the 
staff to divide your music into measures. 
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To delete a measure bar: 

1. Select the measure bar symbol again. 

2. Move the pointer (now a measure bar) directly over the 
measure bar you want to delete, and click the mouse 
button. When you move the pointer aside, the measure 
bar will be gone. 

Setting the Key Signature 

The first time you go to the Main Composing Screen, the key 
signature is always set to the key of C. Unless you change to 
another key signature, any song you write will automatically 
be in the key of C. 

The Key Signature. Use the key signature 
symbol at the bottom left of the screen to pop 
up the key signature menu so that you can set 
a new key signature. 

To change the key signature: 

1. Move the pointer to the key signature symbol at the 
bottom left of the screen, just to the right of the ear 
symbol, and press and hold the mouse button. The key 
signature symbol will be highlighted, and the key 
signature menu will pop up from the bottom of the 
screen. The message box will say Transpose to 
New Key. 
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2. Drag the pointer up and down the menu until the key 
that you want is highlighted, and then release the mouse 
button. The menu will disappear, the new key will appear 
as the key signature symbol, and the proper sharps or flats 
will appear on the grand staff. The music on the screen, 
including any accidentals you have added, will 
automatically be transposed into the new key. 

SeUing the Time Signature 

The Time Signature. Use the time 
signature symbol to select a time signature 
(which indicates the number of beats per 
measure) for the grand staff. 

To select a time signature: 

1. Move the pointer to the time signature symbol at the 
bottom left of the screen, and press and hold the mouse 
button. The symbol will be highlighted and the time 
signature menu will pop up. The message box will say 
Select Time Signature. 

2. Drag the pointer up and down the menu until the time 
signature you want is highlighted, and then release the 
mouse button. The menu will disappear, and the new 
time signature will appear on the grand staff. 
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To erase a time signature: 

1. Click the mouse on the time signature symbol, and the 
time signature will disappear from the staff. You can 
select another time signature from the menu or simply 
not assign one at all. 

Adding Lyrics to a Song 

The Music Studio lets you add up to three separate verses of 
lyrics to any song. You use the computer keyboard to write 
and edit the lyrics, just as you write ordinary text. 

Because lyrics often require more space than the notes that 
accompany them, you may need to open up space between 
the notes on the staff in order to fit your words to the music. 
You can use the Insert Block option to do this (see the 
"Reference Guide," page 85). 

To add lyrics: 

1. Move the pointer to the word Options at the top right 
corner of the screen, and press and hold the mouse 
button to pull down the Options menu. 

2. Drag the pointer down the menu until Add Lyrics is 
highlighted, and then release the mouse button. The 
menu will disappear. 

You'll see a column of numbers (1 through 3) on the left 
side of the screen below the grand staff. These indicate 
the three lines of lyrics you can add. 
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3. Move the pointer to the space just to the right of 1 and 
click the mouse button. A magenta square will appear 
next to 1. 

4. Use the right arrow on the keyboard to move the square 
until it's below the note where you want the first word to 
go. 

5. Type in your words on the keyboard, just as you would 
write ordinary text. As you reach the right edge of the 
screen, the music will scroll to the left to allow you to 
continue. 

To correct a mistake, use the left arrow to move back to 
the point of the mistake, and then type over it. 

6. When you finish the first verse, press the return key. 

7. To write lyrics for the second and third verses, repeat 
steps 3-6 above, starting with the pointer to the right 
of 2 or 3 instead of 1. 

To erase lyrics: 

1. Move the pointer to Options, and pull down the 
Options menu. 

2. Drag the pointer down until Remove Lyrics is 
highlighted, and then release the mouse button. The 
lyrics and numbers will disappear. 
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Note: Whenever you add lyrics to a song, the maximum 
number of notes you can use in a song (8000) diminishes 
because the lyrics take up room in the computer's memory. 
If you try to add more text than the available memory 
allows, you'll get the message No Room in Song. 

Saving a Song 

Once you've composed a song, you can save it on a disk so 
that you can load, play, and revise it whenever you want. 

Don't attempt to save any songs onto the Music Studio 
program disk itself. Instead, save your files onto a separate 
disk, either a blank one or one that has files you don't mind 
erasing. 

Before you can save songs onto a blank disk, it must be 
initialized (formatted). If you need instructions on how to 
initialize a disk, see your Apple IIGS owner's guide. 

Warning: Initializing or formatting a disk automatically 
erases all files on the disk. 

Note: When you save a song, The Music Studio saves both 
the notes you've written and information about the 
instruments you used and the sound data file those 
instruments were taken from. If the folder you're saving your 
song in doesn't already contain the sound data file, then the 
program will copy it into the folder, too. 
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To save a song if you have only one disk drive: 

1. Move the pointer to the word File in the upper left 
corner of the Main Composing Screen, and press and hold 
the mouse button to pull down the Files menu. Drag the 
pointer down until SONG Files is highlighted, and then 
release the mouse button. The Song Files Screen will 
appear (see previous illustration on page 11 ). 

2. Remove the Music Studio program disk from your disk 
drive, and insert an initialized disk. 

3. Move the pointer to the search string (probably = .SNG) 
in the search string box that sits just above the list of files 
(see the Song Files Screen illustration on page 11). Click 
the mouse button, and the program will read the disk you 
just inserted. 

4. Move the pointer to the word Save, and click the mouse 
button. 

5. Move the pointer to the path name (at the top of the 
Song Files Screen- see the illustration on page 11 ), and 
click the mouse button. A vertical bar will replace the 
pointer. 

6. Type in the name you want to save your song under, 
using up to 15 characters. Make the last four characters of 
the name .SNG to match the names of the other song 
files. Press the return key when you're done- your song 
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will be saved in the currently open folder, and the 
pointer will reappear. 

For more information on saving files, see the entry under 
"Save" on page 110 in the "Reference Guide." For 
complete information on file names, folders, and volumes, 
see your Apple IIGS owner's guide. 

7. To return to the Main Composing Screen, move the 
pointer to the word Done, and click the mouse button. 

To save a song if you have more than one disk 
drive: 

1. Move the pointer to the word File in the upper left 
corner of the Main Composing Screen, and press and hold 
the mouse button to pull down the Files menu. Drag the 
pointer down until SONG Files is highlighted, and then 
release the mouse button. The Song Files Screen will 
appear, with a list of song files. 

2. At the top of the list of song files, you will see one or 
more disk symbols (one for each extra drive you have). 
Next to each disk symbol will be the name of the disk 
volume currently in that drive. If you haven't already 
done so, insert an initialized disk into the drive you want 
to use (not necessary if you're using a hard disk drive). 
Then move the pointer to highlight the disk symbol for 
that drive, and click the mouse button. 
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The program will read the disk in the drive you selected and 
list on the screen any files on that disk. All disk operations 
such as loading and saving will now take place on the drive 
you've selected until you change to another drive. 

3. Move the pointer to the word Save, and click the mouse 
button. 

4. Move the pointer to the path name box (at the top of the 
Song Files Screen- see the illustration on page 11 ), and 
click the mouse button; a vertical bar will replace the 
pointer. 

5. Type in the name you want to save your song under, 
using up to 15 characters. Make the last four characters of 
the file name .SNG to match the names of the other song 
files. Press the return key when you're done- your song 
will be saved in the currently open folder, and the 
pointer will reappear. 

For more information on saving files, see the entry under 
"Save" on page 110 in the "Reference Guide." For 
complete information on file names, folders, and volumes, 
see your Apple IIGS owner's guide. 

6. To return to the Main Composing Screen, move the 
pointer to the word Done, and click the mouse button. 
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Loading a Song from Another Disk 

As you start writing your own music, you'll begin to build up 
a library of songs, which will probably be spread over 
several different disks. To load a song from another disk, 
follow these steps: 

If you have only one disk drive: 

1. Move the pointer to the word File in the upper left 
corner of the Main Composing Screen, and press and hold 
the mouse button to pull down the Files menu. Drag the 
pointer down until SONG Files is highlighted, and then 
release the mouse button. The Song Files Screen will 
appear. 

2. Remove whatever disk is currently in your disk drive, and 
insert the disk the contains the song you want to load. 

3. Move the pointer to the search string (probably .SNG) in 
the search string box that sits just above the list of files 
(see the Song Files Screen illustration on page 11 ). Click 
the mouse button, and the program will read the disk you 
just inserted and show a list of files on the new disk. 

4. Any file folders on the new disk will be at the top of the 
file list, represented by folder symbols (with the folder 
names next to the symbols). Open the folder that 
contains the song you want to load by moving the pointer 
to highlight the folder name and then clicking the mouse 
button. After a brief pause, the contents of that folder will 
be shown on the file list. 
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5. Move the pointer to the word Load, and click the mouse 
button. 

6. Move the pointer to highlight the name of the song you 
want to load, and click the mouse button. When the song 
is loaded, the words File Loaded and the song name 
will appear on the screen. 

When the program loads your song, it will also try to load 
the sound data file used when your song was created if 

that file is not the same as the one currently loaded. If the 
program can't find the proper sound data file in the folder 
with your song, it will say so. The program will load the 
song anyway but will play it using instruments from the 
current sound data file. 

7. Click the mouse over the word Done, and the program 
will return to the Main Composing Screen. The music you 
selected will be written on the grand staff, and the song 
title will appear at the top of the screen. 

If you have more than one disk drive: 

1. Move the pointer to the word File in the upper left 
corner of the Main Composing Screen, and press and hold 
the mouse button to pull down the Files menu. Drag the 
pointer down until SONG Files is highlighted, and then 
release the mouse button. The Song Files Screen will 
appear, with a list of song files. 

34 



Usin~ the Main Composing Screen 
'''""''"'"""''""" ''''"'"""'"'"'' " 

2. At the top of the list of song files, you will see one or 
more disk symbols (one for each extra drive you have). 
Next to each disk symbol will be the name of the volume 
currently in that drive. If you haven't already done so, 
insert the disk that contains the song you want to load 
into the drive you want to use. Then move the pointer to 
highlight the disk symbol for that drive, and click the 
mouse button. 

The program will read the disk in the drive you selected 
and list on the screen any files on that disk. All disk 
operations such as loading and saving will now take place 
on the drive you've selected until you change to another 
drive. 

3. Any file folders on the new disk will be at the top of the 
file list, represented by folder symbols (with the folder 
names next to the symbols). Open the folder that 
contains the song you want to load by moving the pointer 
to highlight the folder name and then clicking the mouse 
button. After a brief pause, the contents of that folder will 
be shown on the file list. 

4. Move the pointer to the word Load, and click the mouse 
button. 

5. Move the pointer to highlight the name of the song you 
want to load, and click the mouse button. When the song 
is loaded, the words File Loaded and the song name 
will appear on the screen. 
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When the program loads your song, it will also try to load 
the sound data file used when your song was created if 
that file is not the same as the one currently loaded. If the 
program can't find the proper sound data file in the folder 
with your song, it will say so. The program will load the 
song anyway but will play it using instruments from the 
current sound data file. 

6. Click the mouse over the word Done, and the program 
will return to the Main Composing Screen. The music you 
selected will be written on the grand staff, and the song 
title will appear at the top of the screen. 

Printing a Song 

The Music Studio lets you print out a song as sheet music on 
your printer. 

To print a song: 

1. Be sure the printer is properly connected to your 
computer, plugged in, turned on, and loaded with ribbon 
and paper. 

2. Move the pointer to the word File in the upper left 
corner of the screen, and press and hold the mouse 
button to pull down the File menu. 

3. Drag the mouse down the menu until Print Song is 
highlighted, and then release the mouse button. 
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4. The message Please Make Sure Printer is Ready 
will appear on the screen, as well as two menu options, 
Print and Cancel 

5. To print your music, move the pointer to Print, and 
click the mouse button. Your song will begin printing 
immediately. When the printing is complete, the program 
will return to the Main Composing Screen. 

If you decide not to print your sheet music, move the 
pointer to Cancel, and click the mouse button. The 
program will return you to the Main Composing Screen. 

To stop printing at any time, click the mouse button. 

Note: You can print sheet music for a selected portion of 
a song without lyrics by first marking off the passage and 
then using Print Song as described above. See "Section 
Marker" in the "Reference Guide," page 83. 

Leaving The Music Studio 

You can exit The Music Studio at any time by selecting 
Quit from the File menu on the Main Composing Screen. 

To leave the program: 

1. Move the pointer to the word File in the upper left 
corner of the Main Composing Screen, and press and hold 
the mouse button to pull down the File menu. 
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2. Drag the pointer down the menu until Quit is 
highlighted, and then release the mouse button. You will 
see the warning All work not saved to disk will be 
lost along with two new boxes, OK and Cancel 

3. If you want to keep the current version of your song and 
have not saved it to disk, move the pointer to the word 
Cancel and click the mouse button. The program will 
return to the Main Composing Screen instead of exiting. 

4. If you are ready to leave the program, move the pointer 
to the word OK, and click the mouse button. 

Some Advanced Features 

This guided tour of the Main Composing Screen has covered 
only the basics of working with The Music Studio. As you 
begin to work on more complicated compositions, you'll 
find that The Music Studio has many extra features to help 
you out. When you need these advanced features, you can 
find them all in the "Reference Guide," starting on page 77. 
In the meantime, here are two advanced features to whet 
your appetite. 

Using Sound Files 

With The Music Studio, you aren't limited to just the single 
set of instrument sounds you've been using so far. On the 
Music Studio program disk, there is a selection of files of 
pre-programmed instrument sounds that you can use to 
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replace the current set. You can load these sound files in 
much the same way you loaded the pre-programmed song 
files. 

To load a sound file from the program disk: 

1. Move the pointer to the word File in the upper left 
corner of the screen, and press the mouse button to pull 
down the menu. Still holding down the mouse button, 
drag the pointer down to select SOUND Files. Release 
the mouse button, and the Sound Files Screen will appear, 
along with a list of the sound libraries on the Music 
Studio program disk. The Sound Files Screen looks like 
the Song Files Screen except that it has no Append box. 

2. Click the mouse over the word Load. It will be 
highlighted. 

3. To load any sound file listed on the screen, move the 
pointer until the sound file name is highlighted, and then 
click the mouse button. When the sound file is loaded, 
the words File Loaded along with the sound file name 
will appear in the bottom left corner of the Sound Files 
Screen. 

4. Click the mouse over the word Done, and the program 
will return to the Main Composing Screen. If you now 
pull down the instrument palette from the top of the 
screen and drag the pointer down the palette, you'll see 
that although the colors and numbers on the palette are 
the same, the instrument names associated with each 
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color and number are new. And when you select one of 
these new instruments, you'll find that each color now 
has a new sound, too. 

When you save a song to disk, The Music Studio will 
remember which sound file you used for that song and 
automatically load the proper sounds any time you load the 
song. 

Using Tracks 

The tracks feature lets you isolate one or more instruments 
or sound effects in a song. If, for example, you are creating a 
complicated score and want to work on the percussion 
section separately, without listening to the other 
instruments, you can assign the percussion to a track by 
itself and then turn off all the other tracks so that you see 
and hear only the percussion. 

The tracks feature also lets you place one note on top of 
another without erasing the first note, so that you can 
compose a song with two or more (up to 15) notes on the 
same position on the staff. 

Note: Tracks is the only feature in The Music Studio that 
lets you place one note on top of another note on the staff 
without erasing it. 

To activate the tracks feature: 

1. Move the pointer to Options, and press and hold the 
mouse button to pull down the Options menu. 
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2. Drag the pointer down the menu until Use Tracks is 
highlighted, and then release the mouse button. A small, 
four-track bar will appear underneath the grand staff, and 
a bar of instrument colors will appear at the top center of 
the screen. 

Track Sound 
Palettes 

Current Active Sounds 

Track ON/OFF 
Switches 

The Tl, T2, T3, and T4 rectangles are the on/ off switches 
for tracks 1-4. Simply move the pointer to one of these 
rectangles and click the mouse button to switch a track on 
or off. Switches that are highlighted are on. At the start, only 
Tl is on. 

Use these four on/ off switches to separate the sections of a 
song. For example, you might put a saxophone part on Tl, a 
piano on T2, a bass on T3, and drums on T4. Then, by 
turning tracks on and off, you could listen to each part 
separately, all four parts together, or any combination of two 
or three parts together. 
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Just to the right of each track's on/ off switch is a rectangle 
containing 15 colored squares, which represent the 
instrument palette available for that track. If a square is solid, 
the corresponding instrument is available for use. If a square 
is "hollow" (has a white square within the colored square), 
then the corresponding instrument is inactive and not 
available on that track. To turn an instrument on or off, just 
move the pointer to the appropriate colored square, and 
click the mouse button. 

You can use up to 15 instruments on one track of your 
score. The instrument palette at the top center of the screen 
shows the instruments currently available on all the active 
tracks. 

To use tracks: 

1. To isolate the red and yellow instruments on tracks 1 and 
2, for example, turn off all the tracks except track 1 by 
moving the pointer to the appropriate switches and 
clicking the mouse button. 

2. Move the pointer to the instrument palette for track 1. If 
the red instrument is not already on (solid), the turn it on 
by moving the pointer to the red square and clicking the 
mouse button. When the color is solid, the instrument is 
on. 

3. Turn off all the other instruments on the track 1 palette 
by clicking the pointer on all the other active squares. A 
white square within the colored square indicates that the 
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instrument (color) is inactive (off). You'll now see that 
the instrument palette at the top of the screen shows only 
one red block, indicating that the red instrument is the 
only active one. 

4. Write a line of music or a short song using only the red 
instrument. Remember that you must select the red 
instrument from the pull-down instrument palette on the 
Main Composing Screen first. 

5. Turn off track 1 by moving the pointer to Tl and clicking 
the mouse button. When track 1 is off, all the red notes 
on the staff will be replaced by rests. 

6. Following the procedure you used in steps 1- 3, turn on 
track 2, turn on the yellow instrument, and then turn off 
all the other instruments on the track 2 palette. The color 
bar at the top of the screen will now show only a yellow 
block. 

7. Write a line of music using the yellow instrument. 
Remember to select the yellow instrument from the pull­
down instrument palette menu first. You will see only 
yellow notes on the screen, but the black rests will tell 
you which columns hold the red notes that have been 
turned off. 

When you're done, you can play either the red notes or the 
yellow notes separately by turning on only track 1 or track 
2. To listen to the two lines of music combined, turn on 
both tracks 1 and 2. 
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NOTE: When you're using the tracks feature, you can't 
change a song title, add lyrics or erase rests that are standing 
in for notes. 

To remove tracks: 

1. Move the pointer to Options, and press and hold the 
mouse button to pull down the Options menu. 

2. Drag the pointer down the menu until Remove Tracks 
is highlighted, and then release the mouse button. The 
tracks will disappear from the screen, but their current 
settings will still be saved when you save your song. 
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Exploring Sound 

The Design Instrument Screen is a professional-quality 
sound studio for creating customized instruments and sound 
effects quickly and easily. With it, you can explore and apply 
the sound capabilities of your computer and invent an 
assortment of strange and wonderful sounds. When you save 
a song, any sounds you've designed and used are saved along 
with it. You can also create separate sound files and save 
your creations on disk. 

If you have a MIDI interface in your computer, you can 
connect many synthesizers and other electronic instruments 
to it. Then, you can use The Music Studio to set the 
instrument's voices and play your tunes on it. 

This section briefly introduces some basics of sound theory. 
These will help you understand the concepts behind what 
you see on the screen and show you how to use all its 
features. For a more detailed description of sound theory, a 
good place to start is The Science of Musical Sound by John 
R. Pierce (Scientific American Library, 1983 ). 

To enter the Design Instrument Screen: 

1. Point to and select the Options menu at the top right of 
the screen to highlight the Options menu. Hold the 
button down. 
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2. Highlight Design Instrument and release the button. 
The menu options disappear, and the Design Instrument 
Screen appears. 

Designing Instruments 

Amplitude, Duration, and the Sound Envelope 

Besides their pitch, instrument sounds can be thought of in 
terms of their amplitude (volume) and duration (the time 
the sound takes from beginning to end). With the aid of a 
visual graph, The Music Studio breaks sounds down into 
volume and time values. 

The change in a sound's volume over time is called a sound 
envelope. The Music Studio lets you specify the volume of a 
sound over time in the form of a sound envelope graph. 
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When you select an instrument from the instrument palette, 
you're selecting both a sound and a sound envelope. And 
while each sound file that comes with The Music Studio has 
a maximum of 1 5 sounds available for your use, you can 
control the envelopes of these sounds to create an endless 
variety of unique sounds. Then you can store your new 
sounds in a musical palette that's all your own. 

The graph is labeled ADSR because sound is often defined 
in terms of its ADSR, or Attack, Decay, Sustain, and Release. 

The Attack is how a sound begins. The sound of a piano 
note, generated by a string set in motion by a hammer, could 
be said to have an Attack louder than the rest of its 
envelope, since once the key is struck, the sound gradually 
becomes softer, but never louder. 

The Decay of an envelope is whatever happens to the sound 
immediately after the peak of the Attack. 

The Sustain is the moment in a sound's envelope when the 
Decay levels off and the tone is held evenly. A piano could 
actually be said to have no Sustain, but rather a long decay. 
But a trumpet sound's envelope will have Sustain as long as 
the player keeps blowing enough air in the horn to produce 
a tone. 

The Release is the end of the sound envelope and represents 
how a tone stops. 
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The Music Studio lets you picture the sound envelope as a 
physical shape and hear the sound as it is played- both 
from the Design Instrument Screen. 

By adjusting the graph showing the duration and volume of 
the sound envelope for the 15 sounds in your musical 
palette, you can make up your own custom instruments with 
unique characteristics. 

Notice that the graph on the Design Instrument Screen is 
bordered on the left by an up arrow labeled Volume and on 
the bottom by a right-pointing arrow labeled Time. Each 
sound envelope is divided into from one to seven segments. 

Each segment in the sound envelope graph represents a 
change of volume over time. The maximum volume of the 
envelope is indicated by the arrow to the left of the graph. 

The time for the envelope is displayed below and to the 
right of the graph. 

When you move from segment to segment, the time shown 
below the graph changes to indicate the time associated with 
your current position in a segment. 

The duration of the entire sound envelope is shown to the 
right of the graph. When you make adjustments that affect 
the length of the entire envelope, this number changes. 

The times shown are in seconds. 
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How the Design Instrument Screen Works 

You have at your disposal 15 pre-programmed sounds, 
represented on the instrument palette by numbered and 
colored squares. Each square represents one instrument, or 
sound. 

With the Design Instrument Screen, you can modify these 
pre-programmed sounds from the instrument palette. After 
you've made your modifications and custom designed them, 
they'll automatically be part of the pull-down instrument 
menu. The Music Studio gives you the option of changing 
the parameters for any one or all of the sounds. 

NOTE: In order to permanently save new instrument 
sounds, you must save them in sound files. They are also 
saved if they're used in a song saved in a song file. See 
"Saving Sounds" on page 59. 

A good way to begin this process is to test each pre­
programmed sound and see how it "looks" on the sound 
envelope graph. 

1. Point to the instrument palette symbol at the top left side 
of the screen. Press the mouse button to pull down the 
instrument palette. 

2. Drag the pointer down the palette. As you point to each 
instrument color, the message box tells you which 
instrument is represented by that color and number. 
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Release the pointer at the instrument you wish to see. 
A sound envelope shape appears in the graph area, 
representing the characteristics of the selected sound. 

3. Point to Test and click the mouse. You'll hear the sound 
you selected, played up and down in a continuous scale. 

4. Click the mouse again to turn off the instrument test 
scale. 

5. Cycle through each of the remaining instruments by 
pulling down the palette, clicking the mouse, and turning 
on the sound test. 

Adjusting the Volume 

You can specify the volume of a particular sound at various 
points in time. These points occur at each of the dark 
vertical bars on the graph, called duration time bars. (The 
time spacing of these bars is also adjustable as explained 
below.) Connecting all the time bars is the envelope volume 
line, indicating the variation in the volume that takes place 
between time bars. 

To adjust the volume of a segment: 

1. Point to a duration time bar; the bar changes color. Press 
the mouse button. 

2. Holding the button down, drag the envelope volume line 
by moving the mouse up and down. When the line goes 
up, the volume at the bar is increased. When it goes 
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down, its volume decreases. The volume indicator to the 
left of the graph changes to indicate the new settings. 

3. Release the button to set a volume. You may want to test 
the sound now to hear the change you've made. 

Adjusting the Duration 

By moving the time bars left or right, you can change the 
length of time that a particular segment lasts. 

An instrument envelope may be as long as you wish. The 
duration for your current position in the sound envelope is 
displayed (in seconds) below the graph. As you stretch or 
shorten the durations, the graph automatically "rescales" 
itself to avoid running off the screen or compressing the 
envelope graph into too small a space. 

To move each time bar separately: 

1. Point to the time duration bar you want to move and 

press the button. 

2. Hold the button down and drag the bar to the left or 
right. The segment to the left of the bar shrinks or 
stretches to indicate the adjusted time. The time counter 
below the graph adjusts to display the length of the 
segment in seconds; the counter to the right adjusts to 
reflect the adjusted duration of the sound envelope. 

3. Release the button to fix the bar in place. Test the sound. 
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Adding Time Bars 

As mentioned previously, a sound envelope can consist of as 
few as two segments or as many as seven. 

The first segment always starts at zero volume and zero time. 
It's usually adjusted to move to the maximum volume of the 
sound, either quickly or slowly. The last segment always 
ends at zero volume. 

You can add a segment anywhere within an envelope very 
easily: 

1. Point to the position in the graph where you wish to add 
the new time bar. 

2. Press the mouse button. The new time bar appears. Drag 
the pointer up or down to adjust the volume at this bar. 
Drag the pointer left or right to adjust the duration of the 
segment to the left of this bar. 

3. Release the mouse button to set your changes. 

Eliminating Time Bars 

You can also erase a time bar to simplify a sound envelope: 

1. Point to the time bar you want to erase and hold the 
button down. 

2. Slide the mouse to the left. When the line you're moving 
runs into the line next to it, the two merge. 
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3. Release the mouse button to eliminate the bar and the 
associated segment. 

Alternately, you can drag the volume line at the time bar up 
or down. When the volume at the time bar you've selected 
matches the volume at the bar to its immediate right or left, 
the two merge. 

Controls 

In addition to the controls within the sound envelope, The 
Music Studio offers other controls to help you set the 
characteristics of the sound envelope you're adjusting. 

All 

This control lets you set the volume and duration of an 
entire sound envelope, without altering the overall shape of 
the envelope. 

To use All: 

I. Click All once to highlight it. 

2. Move the pointer to the sound envelope graph and press 
the button. 

3. Drag the envelope around to set a new overall volume 
and/ or duration. Release the button to freeze your new 

settings. 

4. Click All again to switch this feature off 
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Fine 

The Fine control lets you change the amount of variation in 
volume or time caused by movements of the mouse- that 
is, to make adjustments in smaller increments. This makes it 
easier to fine tune your settings. 

To fine tune a setting: 

1. Click Fine once to highlight it. Fine tuning is now on. 

2. Adjust the volume and/ or duration of the segments of the 
sound envelope you wish to reset. 

3. Click Fine again to return to normal adjustment. 

Sustain and Release 

Sustain selects a volume at which to hold the sound for the 
duration of each note. Release selects a point in the sound 
envelope that The Music Studio jumps to when the note 
stops. 

An envelope can have either a sustain or a release point, but 
not both. 

To set Sustain or Release: 

1. Click the Sustain or Release button. The button you 
select is highlighted. 
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2. Move to the time bar where you want a sustain or release 
point, then click. The bar changes colors: red for sustain, 
green for release. 

3. Test your change to see its effect. 

If a sound envelope has a sustain point set, setting a release 
point clears the sustain setting; if it has a release point set, 
setting a sustain point clears the release setting. 

L/ R (Left and Right) 

If you have a stereo card installed in your computer, you 
may assign any sound to either channel. Simply click on the 
L (Left) orR (Right) button to assign the sound to a 
channel. 

Note: You cannot assign a sound to both channels. The 
default assignment is the right channel. 

Vibrato 

Vibrato lets you add regular pitch variations to a sound. 
Depending on the depth and rate you select, this can result 
in no difference, a slight warbling, or a very unusual 
wavering effect. You'll want to try different combinations of 
depth and rate to see how they sound. Click the Vibrato 
button to turn vibrato on or off. You can also turn vibrato off 
by setting either Depth or Rate to zero. 
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Depth controls the amount of variation in the sound when 
vibrato is- on. Lower numbers indicate smaller variations; a 
setting of 0 turns off vibrato. A higher setting causes wide 
changes in the pitch. 

Rate lets you give your vibrato a slow "swirling" sound or a 
fast "trembling" effect- or set it anywhere in between. 
Lower numbers indicate slower rates; a setting of 0 turns off 
vibrato. The highest possible setting is 127. 

To use Vibrato: 

1. Click on Vibrato to highlight it. This turns it on. Click 
Vibrato again to turn it off. 

2. To specify a Rate or Depth, move the pointer to the 
appropriate button, then drag the number in the box up 
or down. Moving up increases the rate or depth, down 
decreases the setting. Note that when the number reaches 
0, dragging down cycles back through the largest 
number- so you can quickly get to higher settings just 
by moving down. 

Selecting an Octave Range 

On the Design Instrument Screen, you can select an octave 
range of up to five octaves for each instrument. And by 
selecting a different octave range for each instrument, you 
can expand the octave range of a song to more than eight 
octaves, even though the grand staff can display only five at a 
time. 
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To select an octave range: 

1. Select an instrument from the instrument palette. 

2. Move the cursor to the thick blue bar on the Octave 
range indicator and press the button. 

3. With the button held down, drag the bar left or right to 
set the octave range, then release. 

Renaming Instruments 

After manipulating the sounds of the pre-programmed 
instruments to make your own custom sounds, you can give 
the sounds new names to distinguish them from the old 
sounds. For example, you may have created a new sound, 
using the pre-programmed "piano" sound. Here's how to 
rename the sound: 

1. Move the cursor to the top of the Design Instrument 
Screen and place it over the first letter of the old name 
immediately following the word Instrument:. Then 
press the button. The old name disappears and a vertical 
editing bar replaces the first letter. 

2. Type the name you've chosen for the new instrument. If 
you make a mistake, erase it with the delete key and 
start again. You can name it anything you want, as long as 
it has no more than nine characters; then press return. 
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If you mistakenly select this feature, simply click the mouse 
button again to retain the instrument's original name. 

If you save your new sound with a new name with a song, 
the name will appear in that form on the instrument palette 
whenever you load this song. 

Changing Samples 

You can use any instrument sound from your musical palette 
with your new sound envelope. 

1. Point to the instrument name to the right of the word 
Sample and press the mouse button. A box listing the 
sounds in your musical palette drops down. 

2. Holding the mouse button, move the pointer down to 
highlight the new sound you wish to try, then release. 
The name of the sound selected appears on screen next 
to Sample. 

Trying a Sound 

Once you've adjusted the envelope to the characteristics you 
want, you can try it out by moving the pointer to Test and 
clicking. A musical scale begins playing at the rate and 
volume set at the bottom of the screen, and using the note 
duration selected at the top of the screen. Click the mouse 
button again to stop the test. 
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Exploring Sounds 

Copying Instruments 

The Music Studio lets you copy an instrument's sound. For 
example, you may want to create two or more "clarinets" on 
the instrument palette, each with a different sound envelope. 
This feature is useful if you want to: 

• Compose a song for three pianos, four violins, and so 
forth. 

• Modify an instrument's sound while still having its original 
ADSR characteristics available. Copy it on the instrument 
palette and work on the duplicated version. 

Undo 

You may undo your changes to a sound envelope at any time 
by clicking the Undo button. You may also undo your last 
use of Undo. 

Saving Sounds 

After you leave the Design Instrument S~reen, you can save 
your new instrument sounds and special effects on a 
separate, formatted disk. 

To save instrument sounds and special effects: 

1. Select the SOUND Files option from the File menu. 
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2. Insert a blank, formatted disk in the drive (drive B if 
you're using two disk drives). 

3. Move the cursor to the long narrow box near the top of 
the screen and click the mouse button. The name in the 
vertical bar disappears and a vertical editing bar appears 
at the left side of the box. 

4. Type a name for the sound file you wish to save. You can 
name it anything as long as the prefix is no longer than 
11 characters. Make the last four characters of the name 
.SND to match the names of other sound files. Press the 
return key when you're finished 

5. Click Save to put your sounds on a disk file. 

6. To return to the Main Composing Screen, move the 
pointer to the word Done and click the mouse button. 

Done 

The Done button lets you move back to the Main 
Composing Screen and use the instruments you've defined. 

MIDI and The Music Studio 

When you install a MIDI interface card in your computer, 
you can connect it to a MIDI-equipped synthesizer or any 
other MIDI musical instrument. Through this connection, 
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you can play tunes you compose with The Music Studio on 
your synthesizer. 

Adjusting MIDI Parameters 

The MIDI Parameters Screen gives you control of a MIDI­
compatible instrument. Just as you use the Design 
Instrument Screen to create your own instruments and 
sound effects for the computer's internal sounds, you can use 
the MIDI Parameters Screen to assign up to 15 different 
instruments and sound effects to your MIDI-compatible 
instrument. 

These instructions apply to the Casio CZ-1 01 series. The 
parameters and channel numbers described in this section 
may vary for other MIDI-compatible instruments. 

To enter the MIDI Parameters Screen: 

1. Move the cursor to the Options menu on the top right 
corner of the screen, and press the button. 

2. Highlight MIDI Parameters on the Options menu 
and release the button. The MIDI Parameters Screen 
appears. 

How to Use the MIDI Parameters Screen 

Start with a song on the Main Composing Screen. To more 
easily experiment with and listen to the different parameters 
for each instrument in a song, start with no more than three 
different instruments or sound effects. Whenever you want a 
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"sound test" of a song, select the ear or running note 
symbols in the lower left corner while you're in the MIDI 
Parameters Screen. 

MIDI SOLO Button: On the Casio CZ-101, the SOLO 
button should be on whenever you use more than one 
instrument color in a song. With the SOLO button on, the 
Casio can play in multi-timbre mode. Turn the SOLO button 
off only when all notes in the song have the same instrument 
color. 

Four MIDI Parameters 

The MIDI Parameters Screen has four adjustable parameters, 
labeled vertically across the screen: 

Instrument 
MIDI channel 
Preset 
Range 

The Sound Palette 

Associated with each parameter is a 15-color palette. Each 
color represents a sound effect or instrument for that 
parameter. 

Instrument Names 

The instrument names on the left come with The Music 
Studio. They can be changed as you adjust the parameters 
for each sound according to your specifications. 
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Exploring Sounds 

NOTE: The instrument names that appear on the Main 
Composing Screen represent the instruments assigned from 
the Design Instrument Screen. The instrument names that 
appear on the MIDI Parameters Screen apply only to sounds 
designed and displayed on that screen. 

To rename a sound: 

1. Move the cursor to the instrument list. 

2. Point to the name of an instrument whose name you 
want to change and press the button. The name 
disappears and a vertical editing bar replaces the first 
letter. 

3. Type a new name. You can pick any name you want as 
long as it has no more than nine characters. Press 
return. 

4. If you change your mind, click the mouse and type in a 
new name. 

Picking a Channel 

The Music Studio lets you assign a MIDI channel for each 
instrument. The Casio CZ-101 receives on four MIDI 
channels, numbers 1-4. You can read the MIDI section of 
your instrument's owner's manual for MIDI channel 
information. 
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To pick a MIDI Channel: 

1. Move the cursor horizontally to the MIDI Channel 
number for the instrument color you're adjusting and 
press the button. 

2. While holding the button down, move the mouse up and 
down until the MIDI channel number you want appears. 

3. Release the button to make the selection. 

NOTE: Do not assign the same MIDI channel to two 
instruments that are playing at the same time. 

Selecting a Preset 

The Preset parameter lets you assign a specific sound to 
each instrument name, based on the MIDI synthesizer you're 
using. The Music Studio gives you the option of using up to 
128 different sounds; the number of sounds you can use 
depends on your MIDI instrument. On the Casio CZ-101, 
you have access to 48 sounds: 16 presets ( 1- 16 ), 16 
cartridge sounds ( 17-32) and 16 internals (33-48). 

You may want to use the same sound for all fifteen 
instruments or different sounds for each. 

To select a sound: 

1. Move the cursor horizontally to the Preset number for 
the instrument color you're adjusting and press the 
button. 
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2. While holding the button down, move the mouse up and 
down (or left and right) until the Preset number you 
want to use appears. 

3. Release the button to make the selection. 

Setting the Octave Range 

The Music Studio gives you the option of assigning a five­
octave range to each instrument, indicated by the numbers 
on the Range parameter. The range "36-90" is the middle 
range, beginning at middle C. Each number represents one 
half-step on the keyboard. The lowest range is "0-60"; the 
highest is "60-120." 

Using the Range parameter, you can stretch the octave range 
of a song by assigning each instrument a different range. 
Although the grand staff can display only five octaves at a 
time, you can actually play nine or ten octaves, depending 
on the MIDI-compatible instrument you're using. 

To change the range: 

1. Move the cursor to the Range parameter for the 
instrument you want to adjust and press the button. 

2. While holding the button down, move the mouse up or 
down until the Range number you want appears. 

3. Release the button to make the selection. 
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Canceling Changes 

Point to and select Undo to return all the parameters to 
their positions when you entered the MIDI Parameters 
Screen. 

Returning to the Main Composing Screen 

Point to and select Done to return to the Main Composing 
Screen. 

Using Your MIDI Parameters 

You must be sure your MIDI instrument is connected and 
that the MIDI control of The Music Studio is switched on. 

1. Point to Options and press the mouse button. The 
Options menu pops down. 

2. Move down the menu to Set MIDI On and release the 
button. The menu disappears and MIDI is now turned on. 
(If MIDI is already on, move back to the top of the menu 
before releasing the button.) 

(If you attempt to turn MIDI on without the MIDI 
interface installed, the message MIDI not available 
appears at the bottom of the screen.) 

3. If you wish to turn off the voices in your computer, point 
to Options and press the mouse button to pop down 
the menu, then move down to highlight Set 11/GS Off 
and release. 
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Saving MIDI Parameters in Sound Files 

MIDI parameters are saved along with any song you use 
them in. 

You also have the option of saving new MIDI parameters on 
separate sound files. To do so, select SOUND Files from 
the File menu and follow the instructions for saving sound 
files on page 59. 
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Using the Music Paintbox 

The Music Paintbox is a free-form method of composing. 
Instead of using standard musical notation, you can "paint" 
notes onto the staff in the form of colored rectangles. The 
size of the rectangle determines how long the note will be 
held, and the color determines which instrument it 
represents. 

If you want, you can use the Paintbox for all your 
composing. The program will automatically translate your 
work to standard musical notation when you enter the Main 
Composing Screen from the Paintbox. 

Opening the Music Paintbox 

To move to the Music Paintbox Screen: 

1. Move the pointer to the very top of the screen at the 
center, where you see the words Music Studio or the 
name of the song that is currently loaded. 

2. Click the mouse button. The screen will briefly go blank, 
and then the Main Composing Screen will be replaced by 
the Music Paintbox Screen. 
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Instrument Instrument Rectangle Note 
Changer Palette Row Eraser 

On the Music Paintbox Screen, you'll see a number of 
features that you're familiar with from the Main Composing 
Screen: the grand staff, the pointer, the song slider, the ear 
symbol, the running note symbol, and the trash can symbol. 

You'll also find several new features on the Music Paintbox 
Screen: 
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The Instrument Changer. The two 
squares separated by an arrow let you change 
notes from one sound to another 
throughout the entire song. 

The Note Eraser. The single square with an 
arrow pointing to an empty space lets you 
erase notes one at a time. 



Using the Music Paintbox 

The Instrument 
Palette. The color 

palette below the song slider represents the instruments you 
can use. 

Wm!iiill'!'m!'!ITJiif&%rm1l''!illi11iii!''rJvt]1:!liillilli~l'rurdii!ti'1stt!i!jtt''Ji~]!!iiiirl'ii!!!rru• The Rectangle Row. 
The row of rectangles represents your "notes." Each 
represents a different note value (the length of time the note 
is held). The color of the rectangles matches that of the 
active instrument. 

Painting Music 

Instead of notes, the Paintbox uses rectangles of five 
increasing widths, corresponding to sixteenth, eighth, 
quarter, half, and whole notes. The program automatically 
uses the rectangle that represents the quarter note unless 
you change to another rectangle (note value). 

Choosing an Instrument 

To select an instrument: 

1. Move the pointer to the instrument palette, and point to 
the color (instrument) you want. 

2. Click the mouse button. Notice that all the rectangles in 
the rectangle row are now the color of the instrument 
you chose. All the rectangles you paint on the grand staff 
will also be this color until you choose a new instrument. 
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Painting Notes on the Staff 

To paint notes on the staff: 

1. Pick a note value by moving the pointer to one of the 
rectangles in the rectangle row and clicking the mouse 
button. That rectangle will be framed in black. 

2. Move the pointer to the grand staff. Notice that the 
pointer now looks like the rectangle you've selected. 

3. To place rectangles (notes) on the staff, move the pointer 
to the place you want a note, and click the mouse button. 
When you move the pointer aside, a colored rectangle 
will remain in that position. 

To play the music you've painted, move the pointer to 
the ear symbol or the running note symbol, and click the 
mouse button. 

Correcting Mistakes 

You can correct mistakes or make changes to your painted 
compositions by either erasing notes one at a time or by 
erasing the entire song. If you want to be able to work with 
a song later, remember to save it before you erase it (see 
"Saving a Song," page 29). 

To Erase a Single Note: 

1. Move the pointer to the note eraser symbol, the box that 
has a blue square with an arrow pointing to a blank space, 
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and click the mouse button. A black frame will surround 
the note eraser box, telling you it's active. 

2. Place the pointer over the note you wish to erase, and 
click the mouse button. The note will disappear. 

The eraser feature will remain active until you turn it off by 
selecting any rectangle in the rectangle row. 

To Erase an Entire Song: 

1. Move the pointer to the trash can symbol. 

2. Double-click the mouse button. Your song will disappear 
from the screen. You can bring back the song by double­
clicking the mouse button again on the trash can before 
selecting any other feature. 

Changing Instruments 

You can substitute one instrument for another throughout 
the song by using the instrument changer to change the 
color of the rectangles on the grand staff. 

1. Move the pointer to the instrument changer, the box that 
has green and red boxes with an arrow in between, and 
click the mouse button. The instrument changer box will 
now be framed in black. 

2. Move the pointer to a new instrument color on the 
palette, and click the mouse button. 
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3. Move the pointer to one of the notes that you want to 
assign to the new instrument, and click the mouse button. 
A screen message will ask if you're sure you want to alter 
the entire song. Type Y if you do; if not, press any other 
key. If you type Y, all the notes of the old color will be 
changed to the new color and will have the sound of the 
new instrument. 

To turn off the change instrument function, point 
to and select any rectangle in the rectangle row. 

Saving A Song 

You can save a painted composition by using the SONG 
Files option from the File Menu on the Main Composing 
Screen. Follow the instructions below for returning to the 
Main Composing Screen, and then follow the instructions for 
"Saving A Song" on page 29. 

Returning to the Main Composing Screen 

To return to the Main Composing Screen: 

1. Move the pointer to the very top of the screen at the 
center, where you see the words Music Studio or the 
name of the song that is currently loaded. 

2. Click the mouse button. The screen will briefly go blank, 
and then the Main Composing Screen will appear. 
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As you switch back and forth between the Music Paintbox 
Screen and the Main Composing Screen, The Music Studio 
will automatically transform a painted song into standard 
musical notation and a composition written in standard 
notation into a painted song. 
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The Reference Guide 

This reference section covers every aspect of The Music 
Studio in a concise form (except the Music Paintbox, which 
is covered in the section starting on page 69). You can use it 
both to refresh your memory of features covered in the 
earlier sections and to explore more advanced features not 
covered elsewhere. 

This section is organized according to the way things appear 
on the screen- all the symbols are illustrated and the menu 
functions are grouped according to the menu they appear 
on. 
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The Main Composing Screen 

The Main Composing Screen is where you do most of your 
composing and editing. It's the largest area of The Music 
Studio and contains the most features and menus. 
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Grand Staff 

The two sets of five lines in the middle of the screen make 
up the grand staff, where you place notes, rests, measure 
bars, and other musical notation. 

Tie and Measure Bar 

The pull-down tie box also includes the measure bar. 

Tie. To add a tie between two adjacent notes 
having identical pitches, move the pointer to 
the tie symbol, press and hold the mouse 
button to pull down the menu, and select the 

tie symbol. After selecting the tie, click the pointer (now a 
red tie) on each of the two notes, connecting them with the 
tie. Only the first note will sound, but for the duration of the 
two notes combined. 

NOTE: You can't use certain block functions (described 
under "Block Functions" on page 84) with the tie. For 
example, you can't move only one of two tied notes to 
another part of the song. 

Measure Bar. Move the pointer to the tie 
symbol, and press and hold the mouse button 
to pull down the menu. Drag the pointer 
down to select the measure bar symbol. After 

selecting the measure bar, move the pointer (now a black 
measure bar) to the point on the staff where you want a 
measure bar, and click the mouse button. 
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Instrument Paleue 

Move the pointer to the instrument palette 
symbol and press and hold the mouse button 
to pull down the full instrument palette of 15 

colors. Drag the pointer down the palette to select a new 
instrument. 

Dot, Accent, and Triplet 

Move the pointer to the dot symbol, and press the mouse 
button to pull down this menu containing the dot symbol, 
the accent symbol, and the triplet symbol. Drag the pointer 
down the menu to select the feature you want. 

Dot. Used in conjunction with a note of any 
value, a dot increases the value of that note by 
half. When the dot is active, both the pointer 
and the note symbol in the message box 

(when the message says Add Note) will be dotted notes. 

Accent. The accent mark, which appears as a 
wedge beneath the accented note, makes a 
note sound with maximum volume. When the 
accent is active, both the pointer and the note 

symbol in the message box (when the message says Add 
Note) will be accented notes. When playing a song with 
accented notes, be sure the volume control slider is not set 
to the maximum volume, or you won't be able to distinguish 
the accented note from the other notes. 
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Triplet. Use the triplet symbol to place 
triplet notes on the staff- a group of three 
notes played in place of two notes of equal 
value. For example, an eighth note triplet 

(three eighth notes grouped as a triplet) is equal in time 
value to two eighth notes or one quarter note. In The Music 
Studio, a triplet is indicated by a 3 following a note. When 
the triplet is active, both the pointer and the note symbol in 
the message box (when the message says Add Note), will 
be triplet notes. 

Note 

The note symbol is used to place notes on the 
grand staff. Pull down the note menu, and drag 
the pointer down the menu to select a note 

duration, from whole note to thirty-second note. When you 
move the pointer into the staff area, it will become a note of 
the duration you selected. Click the mouse button to place a 
note on the staff. 

Message Box 

The message box is located at the top of the screen in the 
center. It tells you, in English, what feature is highlighted or 
what option you have selected. Think of it as an on-screen 
interpreter of all the musical symbols on the Main 
Composing Screen. At the left end of the message box, there 
will be either a note symbol or a rest symbol to show which 
of those two is currently selected. 

82 



Rest 

The rest symbol is used to place rests on the 
grand staff. Pull down the rest menu, and drag 
the pointer down the menu to select a rest 

duration, from whole rest to thirty-second rest. When you 
move the pointer into the staff area, it will become a rest of 
the duration you selected. Click the mouse button to place a 
rest on the staff. 

Key 

Use this menu to add accidentals- sharps, 
flats, and naturals- to your notes. Pull down 
the key menu, and drag the pointer down the 

menu to select a sharp, flat or natural. Once you've selected 
an accidental, every note you place on the staff will have that 
accidental attached, as will the pointer and the note symbol 
in the message box. To cancel the accidental, pull down the 
key menu, and select the key symbol itself. 

Section Marker 

The section marker lets you mark off a section of a song for 
listening or editing. For example, you may want to delete or 
move only a few measures or change the instruments in only 
one passage. 

To Mark Off a Section: 

1. Move the cursor to the white "window" above or below 
the grand staff, and then move it up or down until you 
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reach the edge of the window. Stop when two magenta 
squares appear- one at the top and one at the bottom of 
the screen. 

2. Use the mouse to move the squares horizontally to the 
column at one end of the section you want to mark, and 
click the mouse button. A colored stripe will appear 
running vertically through that column, marking one end 
of the section. 

3. Move the squares horizontally, left or right, to the other 
end of the section you want to mark off. Click the mouse 
button again, and the program will highlight everything 
between your two markers. 

To erase a section marker, move the cursor back to the 
edge of the white grand staff window so that the magenta 
squares reappear, and then click the mouse button. The 
marked section will be unmarked, and the highlighting will 
disappear. 

Once you've marked a section of music, you can listen to 
just the marked section by clicking the pointer on the ear 
symbol. You can also select any of the editing functions 
listed below under "Block Functions" to work with the 
entire marked section at once. 

Block Functions 

The following features are all found in the pull-down block 
menu underneath the insert block symbol. These features 
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can be used to make changes to a section of music marked 
with section markers. Some of these features can also be 
used to change an entire song. When you try to alter an 
entire song, a screen message asks you to confirm that that's 
what you want to do- type Y to make the change, or press 
any other key to cancel the action. 

Move the pointer to the insert block symbol in the top right 
corner of the screen, and press the mouse button to pull 
down this menu of block functions. Drag the pointer down 
the menu to select any of the following functions: 

section. 

Insert Block. Use this feature to insert a 
block of blank columns to the left of a marked 
section. The number of columns inserted will 
equal the number of columns in the marked 

To insert a block of blank columns: 

1. Mark a section equal to the number of columns you want 

to insert. 

2. Select the insert block symbol. 

3. Move the pointer to the marked section, and click the 
mouse button. A block of blank columns equal to the 
marked section will be inserted to the left of the marked 
section. 
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You can insert columns one at a time without first 
marking a section by selecting the insert block symbol 
and then clicking on any column in the staff. For each click 
of the mouse, one blank column will be inserted to the left 
of the pointer. 

Copy Block. Use this feature to copy a 
section of music to another place in a 
composition. 

To copy a block of music: 

1. Use the section markers to mark the section of music you 
want to copy. 

2. Select the copy block symbol. 

3. Move the pointer to the position in the music where you 
want to insert a copy of the marked section. Click the 
mouse button, and a copy of the marked section will 
appear at that point. You may continue to copy the 
marked section as many times as you want. 

Move Block. Use this feature to move a 
section of music to another place in a 
composition. 

To move a block of music: 

1. Use the section markers to mark the section of music you 
want to move. 
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2. Select the move block symbol. 

3. Move the pointer to the position in the music where you 
want to insert the marked section. Click the mouse 
button, and the marked section will be inserted at that 
point. 

Replace Instrument. This feature allows 
you to substitute one instrument for another in 
the marked section or in the entire 
composition- for example, to change all the 

saxophones to pianos. 

To change an instrument in a specific passage: 

1. Use the section marker to mark the passage you want to 
change. 

2. Select the new instrument you want from the instrument 
palette. 

3. Select the replace instrument symbol. 

4. Move the pointer to any note in the marked section 
having the color of the instrument you want to replace. 
Click the mouse button, and all the notes in the marked 
section assigned to the old instrument will automatically 
change to the new one. 
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To replace an instrument throughout an entire 
piece: 

1. Do not mark any section of the music. If any section is 
marked, unmark it before you start. 

2. Select the new instrument you want from the instrument 
palette. 

3. Select the replace instrument symbol. 

4. Move the pointer to any note having the color of the 
instrument you want to replace, and click the mouse 
button. The message Alters entire song! Sure? (y-yes) 
will appear on the screen. Type Y to alter the song or 
any other key to cancel the operation. If you type Y, all 
the notes in the song assigned to the old instrument will 
automatically change to the new one. 

Lengthen Durations. This feature lets you 
lengthen all the note durations in a section or 
an entire song by one step or as many steps as 
the note values allow. For example, all eighth 

notes can be lengthened to quarter notes, quarter notes to 
half notes, and half notes to whole notes. 

To lengthen durations in a specific passage: 

1. Use the section markers to mark the passage whose 
durations you want to lengthen. 
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2. Select the lengthen durations symbol. 

3. Move the pointer to the marked section, and click the 
mouse button. All the notes will be lengthened by one for 
each click. 

To lengthen all the note durations in a song: 

1. Do not mark any section of the music. If any section is 
marked, unmark it before you start. 

2. Select the lengthen durations symbol. 

3. Move the pointer to any place on the grand staff, and 
click the mouse button. The message Alters entire 
song! Sure? (y-yes) will appear on the screen. Type Y 
to lengthen all the notes in the song or any other key to 
cancel the operation. 

Shorten Durations. This feature works the 
same way as Lengthen Durations, but all the 
notes will be shortened by one or more steps. 

Select the shorten durations symbol, and then follow the 
instructions under Lengthen Durations. 

Note: Sixteenth note triplets can't be shortened to thirty­
second note triplets. 
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Transpose Up One Step. Use this feature 
to move all the notes either in a marked 
section or throughout the entire song up one 
or more positions on the staff, depending on 

how many times you click the mouse. If you transpose notes 
above the range of the grand staff display, you will not hear 
them, but they will reappear if you transpose the music 
down again. 

To transpose a specific passage up one step: 

1. Use the selection marker to mark the passage you want to 
transpose up. 

2. Select the transpose up one step symbol. 

3. Move the pointer to the marked section. Click the mouse 
button, and the marked section will be transposed up one 
step. Each further click of the mouse will transpose the 
section up one more step. 

To transpose an entire song up one step: 

1. Do not mark any section of the music. If any section is 
marked, unmark it before you start. 

2. Select the transpose up one step symbol. 

3. Move the pointer to any place on the grand staff, and 
click the mouse button. For each click of the mouse 
button, the entire song will be transposed up one step. 
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Transpose Down One Step. This feature 
works the same way as Transpose Up One 
Step, but the notes are moved one step lower 
on the staff. 

Select the transpose down one step symbol, and then follow 
the directions given above under Transpose Up One Step. 

NOTE: If you transpose notes below the range of the 
grand staff display, you won't hear them, but they will 
reappear if you transpose the music up again. 

Add Repeat. Use this feature to repeat a 
marked section or an entire song without your 
having to re-enter all the notation. You can 
repeat the section or song up to 127 times for 

each repeat, up to the maximum song length. 

To repeat a specific passage: 

1. Use the section marker to mark the passage you want to 
repeat. 

2. Select the add repeat symbol. 

3. Move the pointer to the marked section. Click the mouse 
button, and repeat bars will appear on the screen, with a 
three-digit number (the number of repeats) to the left. 

4. To set the number of repeats, move the mouse up and 
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down until the three-digit number is set to the number of 
repeats you want, and then click the mouse button to set 
the number. 

To repeat an entire song: 

1. Do not mark any section of the music. If any section is 
marked, unmark it before you start. 

2. Select the add repeat symbol. 

3. Move the pointer to the beginning of the song. Click the 
mouse button, and repeat bars will appear on the screen, 
with a three-digit number (the number of repeats) to the 
left. 

4. To set the number of repeats, move the mouse up and 
down until the three-digit number is set to the number of 
repeats you want, and then click the mouse button to set 
the number. 

To erase repeat bars: 

• Mark the repeated section. Be sure to begin the marked 
section at the three-digit number and end it at the repeat 
sign. Select the add repeat symbol, and change the repeat 
number to 001. 

or 

• Mark the three-digit number, and use the trash can to 
delete it. Then mark the repeat sign, and use the trash can 
to delete it also. 
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Song Slider 

Use the song slider to scroll back and forth through a song. 
To move the song slider, place the pointer on the black 
square inside the main part of the slider, and press and hold 
the mouse button. Drag the pointer left or right, and the 
slider will move with it. As you move the slider, the number 
in the box to the left of the slider (the current column 
number) will change to reflect your current position in the 
song. If you release the mouse button, or if you hold the 
slider still for more than a second, the music from your 
current position in the song will appear on the staff 

To move directly to the end of the song, move the pointer 
to the box at the right end of the song slider, and click the 
mouse button. To move directly to the beginning of the 
song, move the pointer to the box at the left end of the 
slider, and click the mouse button. 

Current Column Number 

The number in the box at the left end of the 
song slider is the current column number. When you scroll 
through a song or move the pointer on the grand staff, this 
number changes to reflect the current position of the 
pointer. To jump directly to the beginning of a song, move 
the pointer to this box, and click the mouse button. 

lfpYIIIJ- Total Column Number 

The number in the box at the right end of the 
song slider is the total column number. This number always 
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gives you the total length of the song in columns. As you add 
to a song, this number will increase. To jump directly to the 
end of a song, move the pointer to this box, and click the 
mouse button. 

Trash Can 

To delete an entire song or a marked section 
of a song, move the pointer to the trash can, 
and double-click the mouse button. 

To delete a specific passage: 

1. Use the section marker to mark the passage you want to 
delete. 

2. Move the pointer to the trash can, and click the mouse 
button. The trash can will be highlighted, and the 
message box will say Erase Block 

3. If you decide you don't want to delete the section after 
all, just move the pointer away from the trash can; the 
trash can will no longer be highlighted. If you do want to 
delete the section, click the mouse button a second time, 
and the marked section will disappear. 

To erase an entire song: 

1. Do not mark any section of the music. If any section is 
marked, unmark it before you start. 
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2. Move the pointer to the trash can, and click the mouse 
button. The trash can will be highlighted, and the 
message box will say Erase Song. 

3. If you decide you don't want to delete the song after all, 
move the pointer away from the trash can; the trash can 
will no longer be highlighted. If you do want to delete 
the song, click the mouse button a second time, and the 
entire song will disappear. 

Note: If you change your mind after erasing an entire song, 
you can bring it back by moving the pointer to the trash can 
and double-clicking the mouse button before you select any 
other feature. 

Volume Control Slider 

Use the volume control slider to adjust the 
overall loudness of the music. Place the pointer on the white 
knob of the volume control slider, press and hold the mouse 
button, and then drag the knob to the right or left. As you 
move the slider, the program will display the musical 
abbreviation for each volume setting, from pp 
(pianissimo- very soft) to .ff (fortissimo- very loud). 

56 200 Tempo Slider 
.... ;~m .... 

Use the tempo slider to adjust the tempo 
(speed) of the music in the same way that you use the 
volume control slider to adjust the volume. As you drag the 
tempo slider knob right and left, the program will display the 
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musical term and the number of quarter notes per minute 
for each tempo setting. 

Time Signature 

Use this feature to select a time signature for 
the grand staff. 

To select a time signature: 

1. Move the pointer to the time signature symbol, just to the 
left of the tempo slider, and press and hold the mouse 
button to pop up the time signature menu. 

2. Drag the pointer up and down the menu until the time 
signature you want is highlighted, and then release the 
mouse button. The time signature you selected will 
appear on the grand staff. 

To remove a time signature entirely, move the 
pointer to the time signature symbol, and click the mouse 
button. The time signature will disappear from the staff. 

Note: The time signature serves only as a reminder to you 
of the time you have chosen. It does not affect the notes on 
the staff in any way. 
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your song. Unless you select a different key, 
The Music Studio uses the key of C. When you 



change from one key to another, the program automatically 
transposes all the notes to the new key. 

To select a key signature: 

1. Move the pointer to the key signature symbol, and press 
and hold the mouse button to pop up the key signature 
menu. 

2. Drag the pointer up and down the menu until the key 
signature you want is highlighted, and then release the 
mouse button. The new key signature will appear on the 
grand staff, and any music on the staff will automatically 
be transposed into the new key. 

Note: The key signature menu is arranged from bottom to 
top in order of the increasing number of sharps and flats. It 
starts at the bottom with the key of C (no sharps or flats) 
and then goes from G (one sharp) to C-sharp (seven sharps) 
and from F (one flat) to C-flat (seven flats). 

Ear 

To play the song that is currently loaded, 
move the pointer to the ear symbol, and click 
the mouse button once. The music will play 

starting from the very beginning of the song. 

To stop the music at any point, just click the mouse button 
once. 
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The Running Note 

To play the music that is currently displayed 
on the screen, move the pointer to the 
running note symbol, and click the mouse 

button once. The music will play starting with the notes in 
the leftmost column on the screen. To play from the very 
beginning of a song with the running note, click the pointer 
on the current column number to jump directly to the first 
note of the song, and then click the pointer on the running 
note. 

When you play a song using the running note symbol instead 
of the ear symbol, the music will scroll across the screen as 
it's played. To stop the music at any point, just click the 
mouse button once- the music will stop playing, and the 
screen will display the notes at the point where the song 
was interrupted. 

Blue Arrows 

You can use this feature instead of the song 
slider to scroll the music in either direction. 

1. Move the pointer to the extreme left or right edge of the 
screen, while keeping it within the white area around the 
grand staff. When the pointer reaches the edge of the 
screen, blue arrows will appear at the top and bottom of 
the grand staff area. 
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2. Click the mouse button once. The music on the staff will 
scroll one column in the direction indicated by the blue 
arrows. For each further click, the music will scroll one 
more column. Press and hold the mouse button to make 
the music scroll continuously. 

The Options Menu 

To pull down the Options menu, move the pointer to the 
word Options at the top right corner of the Main 
Composing Screen, and press and hold the mouse button. 
Drag the pointer down the menu to highlight its various 
features. You can select any of the following features from 
the Options menu by releasing the mouse button when the 
feature you want is highlighted. 

Design Instrument 

Select this option to enter the Design Instrument Screen, 
where you can custom-design your own instruments and 
sound effects using the computer's internal sounds. See 
"Exploring Sound" beginning on page 45. 

MIDI Parameters 

Select this to enter the MIDI Parameters Screen for assigning 
instruments and sound effects to an external MIDI­
compatible instrument. See "MIDI and The Music Studio" 

beginning on page 60. 
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Change Song Title 

You can use this feature to title your songs, replacing the 
title at the top of the screen with one of your own choosing. 
This feature only changes the title that appears on the 
screen. It does not change the file name you use to load and 
save the song; that name can only be changed from the Song 
Files Screen. 

To change a song tide: 

1. Select Change Song Tide from the Options menu. 
The word tide will appear on the lower part of the 
screen followed by a colon and a vertical bar. 

2. Type in the title. You're allowed up to 30 characters in 
your song title. You can make corrections by using the 
left arrow key to back up to the mistake and then typing 
over it. 

3. Press the return key when you're done. Your new title 
will appear at the top of the screen. If you save your song 
to disk, the song title will be saved with it and will appear 
each time you load the song. 

Add Lyrics 

Use this feature to add up to three lines of lyrics to your 
song. The lyrics will be displayed along with the song, 
underneath the grand staff. 
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To add lyrics: 

1. Select Add Lyrics from the Options menu. A column 
of numbers ( 1 through 3) will appear on the left side of 
the screen below the grand staff. These indicate the three 
lines of lyrics you can add. 

2. Move the pointer to the space just to the right of 1 and 
click the mouse button. A magenta square will appear 
next to 1. 

3. Use the right arrow on the keyboard to move the square 
until it's below the note where you want the first word 
to go. 

4. Type in your words on the keyboard, just as you would 
write ordinary text. As you reach the right edge of the 
screen, the music will scroll to the left to allow you to 
continue. 

To correct a mistake, use the left arrow to move back to 
the point of the mistake, and then type over it. 

6. When you finish the first verse, press the retum key. 

7. To write lyrics for the second and third verses, repeat 
steps 2-6 above, starting with the pointer to the right of 2 
or 3 instead of 1. 
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To remove lyrics from a song, pull down the Options 
menu again, and select Remove Lyrics. The lyrics and line 
numbers will disappear. 

Note: Whenever you add lyrics to a song, the maximum 
number of notes you can use in a song ( 8000) diminishes 
because the lyrics take up room in the computer's memory. 
If you try to add more text than the available memory 
allows, you'll get the message No Room in Song. 

Use 1 Instrument 

This feature allows you to hear all parts of your song played 
by a single instrument so that you can experiment with 
different instrument sounds. 

To play a song using one instrument, select Use 1 
Instrument from the Options menu, and then play the 
song. All the notes will have the sound of the instrument 
currently selected from the instrument palette. To hear the 
notes played by a different instrument, choose a new 
instrument from the instrument palette. 

To play a song using all instruments again , pull 
down the Options menu, and select All Instruments. 
The song will now play using its specified instruments. 

Turn Note Off 

Use this feature to keep the pointer-note from sounding 
tones as you move it across the grand staff. 

102 



To turn the note off, pull down the Options menu, 
and select Turn Note Off The note-pointer will now make 
no sound as you move it around the staff, but songs will still 
play normally when you select the ear or running note 
symbols. 

To turn the note on again , pull down the Options 
menu again, and select Turn Note On . The note-pointer 
will now sound the pitch of every line or space that it 
touches on the staff. 

Turn MIDI On/Off and Turn II/GS On/Off 

Use these when you have a MIDI interface installed and wish 
to control it with your computer. Turn 11/GS On/Off 
controls the internal voices of your computer- turn them 
off when you wish to hear only your MIDI instrument. Turn 
MIDI On/Off controls the external instrument- turn it on 
when you wish to play the MIDI instrument from The Music 

Studio. 

(If you attempt to turn MIDI on without the MIDI interface 
installed, the message MIDI not available appears at the 
bottom of the screen.) 

See "MIDI and The Music Studio" beginning on page 60. 

Use Tracks 

This feature lets you isolate one or more instruments or 
sound effects in a song by assigning instruments to one of 
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four separate tracks and then turning the tracks on and off. 
The tracks feature also lets you place one note on top of 
another without erasing the first note, so that you can 
compose a song with two or more (up to 15) notes on the 
same position on the staff. 

For a complete description of how to use tracks and an 
illustration of the tracks screen, see "Using Tracks," page 40, 
in the "Using the Main Composing Screen" section of this 
guide. 

To activate tracks , select Use Tracks from the 
Options menu. A small, four-track bar will appear 
underneath the grand staff, and a palette of instrument colors 
will appear at the top center of the screen. 

To remove tracks , pull down the Options menu again, 
and select Remove Tracks. The tracks will disappear from 
the screen, but their current settings will still be saved when 
you save your song. 

The File Menu 

In The Music Studio, all file operations start from the File 
menu. Through this menu, you can load, save, delete, or 
rename song files or sound files, append or print song files, 
and quit the program. 

To pull down the File menu, move the pointer to the word 
File at the top left corner of the Main Composing Screen, 
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and press and hold the mouse button. Drag the pointer 
down the menu to highlight its various features. You can 
select any of the following features from the File menu by 
releasing the mouse button when the feature you want is 
highlighted. 

SONG Files 

To load, save, delete, rename, or append song files, pull 
down the File menu, and select SONG Files. The Song 
Files Screen will appear in the white area usually occupied 
by the grand staff. 

Search String 

Close Box 

File List 

File List 
Slider 

Song File List 

Path :-lame 

In the large box in the middle of the Song Files Screen, you 
will see a list of file names. These names are a partial list of 
the files to be found on the disk that's in the currently 
selected disk drive. To scan the full list of files, use the file 

list slider. 
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When you first enter the Song Files Screen, the file list will 
show all the files that match the search string (probably 
= .SNG, the standard ending for song file names). You can 
change the file specification to show other files also, by 
changing the search string (see below). 

At the top of the file list you may see some file folders, 
identified by the folder symbol plus the name of the folder. If 
you want to open one of the folders on the list, move the 
pointer so that the folder you want to open is highlighted, 
and then click the mouse button. After a brief pause, the file 
list will display all the files in that folder which match the 
file specification set by the current search string. To close a 
folder, move the pointer to the small close box at the left of 
the search string, and click the mouse button. 

If you have more than one disk drive, then at the top of the 
file list you will also see one or more disk symbols, each 
representing a disk drive. Next to each symbol, you'll see the 
name of the volume in that drive. To switch to a different 
disk drive, move the pointer to highlight the disk symbol and 
volume name you want, and then click the mouse button. 
After a second, the file list will show you the files on the 
newly-selected drive. 

File List Slider 

At the right edge of the box containing the file list is a tall, 
narrow rectangle with a smaller rectangle inside it- the file 
list slider. To scan through the complete list of files, move 
the pointer to the inside rectangle of the file list slider, and 
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press and hold the mouse button. As you drag the pointer up 
and down, the list of files will scroll from beginning to end. 

Search String 

Directly on top of the box containing the file list is a wide, 
short rectangle, which contains a small square (the close 
box) at its left end and the search string. The search string 
indicates what file specification is being used to select the 
files shown in the file list. When you first get to the Song 
Files Screen, the search string will be set to = .SNG, which 
indicates that the file list shows only files whose names end 
with .SNG. 

Note: You can't change the search string by typing in the 
search string box itself. Instead, you must enter a new path 
name (see below). 

You can do two things in the search string box: 

• If you need to change the disk in the current disk drive, 
then remove the old disk, insert the new one, move the 
pointer to the middle of the search string box, and click 
the mouse button. The program will read the new disk 
and list its files, according to the current search string. 

• If you want to see the folders available on the current 
disk, then move the pointer to the close box at the left 
end of the search string box, and click the mouse button. 
The program will close the current folder and show you 
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the contents of the preceding folder on the path. Each 
click of the mouse button will move you one step back up 
the path (see path name, below). 

Path Name 

Just under the words Song Files at the top of the Song Files 
Screen is a rectangular box running the width of the screen. 
This box contains the path name, which consists of the name 
of the current disk volume, followed by the name of the 
current file folder (there may be more than one), and ending 
with the name of the current file. For example, the path 
name / AUDIOLIGHT/MSTUDIO/SONGS/BEBOP .SNG 
indicates that the currently loaded song, BEBOP .SNG, is in 
the folder SONGS, and that SONGS is itself in the folder 
MSTUDIO, which is on the volume named AUDIOLIGHT. 
Whenever you load another song file, the path name will 
change to include the new name. 

If a path name is too long to fit in the path name box, it will 
be truncated at the front, and an asterisk ( *) will appear as 
its first character. The full path name will still be in effect, 
however, including the parts not shown on the screen. 

To change the search string (see above), move the pointer 
to the path name box, and click the mouse button. The path 
name will disappear, and a vertical bar will appear at the left 
end of the path name box. Type in the new search string 
you want to use to select files, and press the return key. 
The new search string will appear in the search string box, 
and the program will list all the files that match the string. 
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When you enter a new search string, you can use the = as a 
wildcard. That is, if you enter the search string = .SNG, the 
program will list all the files with names that end .SNG. If 
you enter B =, the program will list all the files whose 
names begin with B. 

For general information on path names, folders, files, and file 
names, see your Apple IIGS owner's guide. 

Load 

To load a song, Move the pointer to Load, and click the 
mouse button. Then scroll through the file list until you see 
the song you want to load, move the pointer to highlight the 
song's name, and click the mouse button. After a brief pause, 
the words File Loaded and the name of the song file will 
appear at the bottom of the screen. The song file name will 
also appear as part of the path name. 

If you want to load a song file that isn't on the file list, select 
Load as above. Then move the pointer to the path name 
box, click the mouse button, and enter a new path name 
(including the name of the file you want to load) as 
described above. When you press the retum key, the 
program will load the file you specified. 

When The Music Studio loads a song from a disk, it 
checks to see what sound data file was used to create the 
instruments in the song. If that sound data file is not 
currently loaded, the program will load it along with the 
song. If the program can't find the proper sound data file 
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in the current folder, it will tell you so, then load the song 
anyway. You will still be able to play the song, but it will be 
played using sounds from the currently loaded sound 
data file. 

Save 

To save a new song you have written or an existing song 
you've altered, move the pointer to Save, and click the 
mouse button. Then move the pointer to the path name box, 
and click the mouse button again. The path name will 
disappear, and a vertical bar will appear at the left end of the 
box. Type in the name you want to save your song under, 
using up to 15 letters and ending with .SNG (the standard 
song file name ending). Press the return key, and after a 
pause, the message File Saved will appear on the screen 
with the name of your song. 

If the song name you enter is the same as that of an existing 
song, the message Replace existing file? will appear. 
Type Y to have your new file overwrite the old file, or press 
any other key to cancel the operation. 

If the song name you want to use is in the current path 
name, you can save your song by moving the pointer to 
Save and double-clicking the mouse button. 

You can save the song file in a different folder by specifying 
the full path name, including volume and folder names, 
when you type in the file name. 
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The Reference Guide 

When The Music Studio saves your song, it checks to see if 
the folder you're placing the song in contains a copy of the 
sound data file used to create the song's instruments. If not, 
then the program will place a copy of the sound data file 
in the folder along with your song. The sound data file is 
a large file, so it takes extra time and extra disk space to 
save it. 

Append 

If you want to load a song from a disk and add it to the song 
currently displayed on the Main Composing Screen, move 
the pointer to Append, and click the mouse button. Then 
move the pointer to the song files list, highlight the song to 
load, and click the mouse button. After a few seconds, the 
message File Appended will appear along with the name of 
the file you selected. 

The song you append from the disk is always added to the 
end of the file currently displayed on the Main Composing 
Screen. If the combined songs are too long to be displayed 
together, the program will tell you so. 

You can also specify the name of the song to append by 
specifying a new path name, as described above. 

Rename 

To rename an existing song file, move the pointer to 
Rename, and click the mouse button. Then move the 
pointer to the files list, highlight the song you want to 
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rename, and click the mouse button again. The message 
New name: will appear on the screen with a vertical bar 
next to it. Type in the new name you wish to use for the 
song file, and press the return key. After a few seconds, the 
message File Renamed will appear on the screen, and the 
song file will appear on the files list under its new name. 

Delete 

To delete a song file from the disk, move the pointer to 
Delete, and click the mouse button. Then move the pointer 
to the files list, highlight the name of the song you want to 
delete, and click the mouse button again. The message Are 
you sure? will appear on the screen. Type Y to delete the 
song. Press any other key to cancel the operation if you 
decide not to delete the song. 

Done 

To leave the Song Files Screen and return to the Main 
Composing Screen at any time, move the pointer to Done, 
and click the mouse button. 

SOUND Files 

On The Music Studio program disk, you'll find a selection of 
sound files with file names ending in .SND, each containing 
a different mix of instrument sounds from the main sound 
data file. When you load one of these sound files, the 
instrument sounds it contains become the new instrument 
palette, replacing the previous instruments. You can write 
songs using these new instruments just as you did before, 
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and when you save your song, The Music Studio will 
remember which sound file you used and load it 
automatically any time you load the song. 

To load, save, delete, or rename sound files, pull down the 
File menu, and select SOUND Files. The Sound Files 
Screen will appear in the white area usually occupied by the 
grand staff. 

The Sound Files Screen looks exactly like the Song Files 
Screen (shown earlier), except that it says Sound Files at 
the top and has no Append box (you can't append sound 
files). The file list, file list slider, search string, and path name 
all work just like their counterparts on the Song Files Screen, 
as do Load, Save, Rename, Delete, and Done. 

Note: Though you can use the search string to list all files 
from either the Song Files or Sound Files Screen, you can't 
load a song file from the Sound Files Screen or vice-versa. 

Print Song 

If you have a printer connected to your computer, you can 
print a song as sheet music. 

To print a song: 

1. Be sure the printer is properly connected to your 
computer, plugged in, turned on, and loaded with ribbon 
and paper. 
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2. Pull down the File menu, and drag the pointer down the 
menu to select Print Song. The message Please Make 
Sure Printer is Ready will appear on the screen, as 
well as two menu options, Print and Cancel. 

3. To print your music, move the pointer to Print, and 
click the mouse button. When the printing is complete, 
the program will return to the Main Composing Screen. 
To interrupt printing at any time, click the mouse button. 

If you decide not to print your sheet music, move the 
pointer to Cancel, and click the mouse button. The program 
will return you to the Main Composing Screen. 

Note: You can print sheet music for a selected portion of 
a song without lyrics by first marking off the passage using 
the section marker. 

Quit 

To leave The Music Studio, pull down the File menu, and 
select Quit You will see the warning All work not saved 
to disk will be lost along with two new boxes, OK and 
Cancel 

If you want to keep the current version of your song and 
have not saved it to disk, move the pointer to the word 
Cancel and click the mouse button. The program will return 
to the Main Composing Screen instead of exiting. 

If you are ready to leave the program, move the pointer to 
the word OK, and click the mouse button. 
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A SHORT GLOSSARY OF MUSICAL TERMS 

Accent 

An accent sign with a note means that the note should be 
played louder than the other notes. In The Music Studio, the 
accented note is played to the maximum volume (",ff''). 

Chord 

A chord is formed by two or more notes playing at the same 
time. In The Music Studio, two or three notes in the same 
column will form a chord. 

Dotted Notes 

Placing a dot after a note increases that note's duration by 
half of its original number of counts. For example, if a half 
note equals two counts, a dotted half note will equal three 
counts. 

Keys and Key Signature 

A song using the notes C-0-E-F-G-A-B-C would be in the key 
of C-major. A song using the notes in a G-major scale (G-A-B­
C-0-E-F-sharp-G) would be in the key of G. 

You can tell what key a song is in by looking at the 
beginning of the staff. This is called the key signature. 

For example, the notes of the G-major scale include one 
sharp- an F-sharp. Whenever you see a key signature 
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consisting of one sharp (in this case, on the F line), you 
know the key is G-major. If you're in the key of G and you 
want to notate an F without a sharp, you must use the 
natural symbol. 

Measure Bars 

These are used to separate the staff into sections of equal 
duration. For example, in a song written in 4/4 time, each 
measure contains notes whose combined values equal four 
counts. 

Notes 

Notes are used to represent musical tones. The duration and 
pitch of a tone is determined by the note's shape and 
position on the staff. 

Octave 

The interval between one note and the next one having the 
same name is called an octave. Notes of the same name have 
a similar sound. 

Pitch 

Pitch is the high or low quality of a musical tone, 
determined by the frequency, or number of vibrations per 
second, of a sound. Each pitch, or tone, is represented by a 
different note on the scale. 
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Repeats 

If you'd like to repeat a musical passage, you don't have to 
notate the entire passage again. Just use repeat signs. The 
repeat sign designates a repeat from any point in the song 
where the repeat sign has been placed. 

Rests 

- 7 
whole note rest 4 counts eighth note rest %count 

- :; 
half note rest 2 counts sixteenth note rest 14 count 

~ q 
quarter note rest 1 count thirty-second note rest Vs count 

In musical notation, silence is indicated by a "rest." Rests, 
like notes, are categorized by their durations. 
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A scale is a succession of tones with specific distances 
between them. Scales are usually played in a 
descending/ascending order. The most common example of a 
scale is "Do-Re-Mi-Fa-So-La-Ti-Do," known as a major scale. 
There are also minor scales, chromatic scales, Dorian scales 
and many more. If the word "Do" in the above scale were a 
C note, the scale would be a C-major scale, and the notes 
would be C-D-E-F-G-A-B-C. 

Sharps and Flats 

These "accidentals" are used to indicate the tones between 
the letter-notes, except between B and C and between E and 
F, which are themselves half tones and can't "squeeze" a 
tone in between. Sharps raise notes a half-step; flats lower 
notes a half-step. Naturals cancel out sharps and flats. 

On the screen display and in your print-outs, accidentals will 
appear above, not next to, the notes. 
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Glossary 

The Staff 

Musical notation is written on a series of horizontal lines and 
spaces called the staff. The grand staff, like the one used in 
The Music Studio, is composed of the treble staff and the 
bass staff. The treble staff is the upper staff, the bass staff the 
lower one. Together, they'll accommodate all the notes 
you'll use. 

Tempo Markings 

Tempo markings tell a musician how slow or fast to play the 
music. In The Music Studio, you'll find them under the 
tempo selector in Italian. (Standard musical notation is 
usually written in Italian.) They range from Grave (very 
slow) to Prestissimo (very fast). 

Ties 

You can sustain (hold) a note from one note to the next 
note by using a "tie" sign. The two notes must have the same 
pitch and must be next to each other. Although only the first 
note is played, it's held for the combined duration of both 
notes. 

A tie that connects two or more notes of different pitches is 
called a "slur." 

Time Signature 

Used to designate the number of beats for each measure, the 
time signature is displayed as a fraction; the top number is 
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the number of beats in a measure, and the bottom number is 
the note value that has one beat. For example, 3/4 means 
there are three beats to a measure and a quarter note gets 
one beat; in 4/4 time, there are four beats to a measure and a 
quarter note gets one beat. 

Time Value of Notes 

A note's duration is shown by the way it's drawn on the staff. 
Each type of note is held for a different number of counts, as 
follows: 

0 whole note 4 counts 

) J eighth note %count 
half note 2 counts 

) quarter note 1 count ) sixteenth note '4 count 

Transpose 

When a song's range is either too high or too low, you can 
transpose, or change it to another key. In The Music Studio, 

the program does all the transposing for you- instantly. 
Otherwise you'd have to do it all by hand. 

Triplets 

A group of three notes played for the duration of two notes 
of the same value is called a triplet. In The Music Studio, the 
number 3 designates a triplet. 
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Volume Markings 

Known as "dynamic" signs, these indicate how loudly or 
softly the music should be played. In The Music Studio, 
you'll find them to the left of the volume control slider, 
ranging from pp (very soft) to .ff (very loud). 
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ACTIVISION LIMITED 90-DAY WARRANTY 
Activision, Inc. warrants to the original consumer purchaser of this computer 
software product that the recording medium on which the software programs are 
recorded will be free from defects in material and workmanship for 90 days from 
the date of purchase. If the recording medium is found defective within 90 days of 
original purchase, Activision agrees to replace, free of charge, any product 
discovered to be defective within such period upon receipt at its Factory Service 
Center of the product, postage paid, with proof of date of purchase. 

This warranty is limited to the recording medium containing the software program 
originally provided by Activision and is not applicable to normal wear and tear. This 
warranty shall not be applicable and shall be void if the defect has arisen through 
abuse, mistreatment, or neglect. Any implied warranties applicable to this product 
are limited to the 90-day period described above. If the recording medium should 
fail after the original 90-day warranty period has expired, you may return the 
software program to Activision, Inc. at the address noted below with a check or 
money order for $7.50 (U.S. currency), which includes postage and handling, and 
Activision will mail a replacement to you. To receive a replacement, you should 
enclose the defective medium (including the original product label) in protective 
packaging accompanied by: ( 1) a $7.50 check, ( 2) a brief statment describing the 
defect, and (3) your return address. EXCEPT AS SET FORTH ABOVE, THIS 
WARRANTY IS IN UEU OF ALL OTHER WARRANTIES, WHETHER ORAL OR 
WRITTEN, EXPRESS OR IMPUED, INCLUDING ANY WARRANTY OF 
MERCHANTABIUTY OR FITNESS FOR A PARTICULAR PURPOSE, AND NO OTHER 
REPRESENTATION OR CLAIMS OF ANY NATURE SHALL BE BINDING ON OR 
OBUGA TE ACTIVISION. IN NO EVENT WILL ACTIVISION BE UABLE FOR SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGE RESULTING FROM POSSESSION, 
USE, OR MALFUNCTION OF THIS PRODUCT, INCLUDING DAMAGE TO 
PROPERTY AND, TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR 
PERSONAL INJURY, EVEN IF ACTIVISION HAS BEEN ADVISED OF THE 
POSSIBIUTY OF SUCH DAMAGES. 

SOME STATES DO NOT ALLOW UMITATIONS ON HOW LONG AN IMPUED 
WARRANTY LASTS AND/OR THE EXCLUSION OR UMITATION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE UMITATIONS AND/OR 
EXCLUSION OR UMITATION OF UABIUTY MAY NOT APPLY TO YOU. THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER 
RIGHTS WHICH VARY FROM STATE TO STATE. 

WARNING 
Any attempt to duplicate this product may damage it. Such damage is not covered 
by the warranty. Please see above for complete warranty. U.P.S. or registered mail is 
recommended for returns. Please send to: 

WARRANTY REPLACEMENTS 
Consumer Relations 

Activision, Inc. 
2350 Bayshore Parkway 

Mountain View, CA 94043 
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